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INTRODUCTION 

  

Each type of transport is evaluated according to separate criteria and indicators 

of performance evaluation, which reflect different aspects of the organization of the 

transport process. At the same time, a number of common indicators can be identified 

that characterize the advantages and features of a particular mode of transport. 

Planning the work of the transport industry is to compile an annual (quarterly) 

plan of production and economic activities to break down the main indicators by 

month. This plan provides for the calculation of the production program (transportation 

plan), the volume of loading and unloading, the number of vehicles and machinery, the 

number of workers, wages, cost estimates and other indicators of transport. 

Analysis of the existing methods of planning the volume of traffic on road 

transport shows that most of the calculation methods are used, which do not provide a 

scientific basis for plans for the transportation of goods. 

To increase the scientific validity of cargo transportation plans are traditional 

methods planning worth it to supplement more wide range of economic and 

mathematical methods and forecasting methods. 

To date, more than 130 different methods, techniques and typical models are 

known, which are used or proposed for use in forecasting. 

In terms of the interdependence of past and future, there are two types of 

forecasts - research and intuitive. Research predictions are developed after studying 

systematic information about the state, behavior, and causes of changes in the predicted 

process and are based on rigorous mathematical methods that take into account the 

inertia of the process, while intuitive predictions usually have a large "horizon" for 

forecasting. becomes scientific or practical intuition. 

Nowadays, the following basic methods are distinguished: qualitative analysis, 

extrapolation, expert evaluations and modeling. 

The developed classification of forecasting methods allows to choose a certain 

method for forecasting the volume of traffic and other performance indicators of motor 

transport enterprises based on the analysis of the dynamics of the economic situation 
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for the previous period. Forecasting the volume of traffic is based on the results of the 

analysis of the past, therefore, describes the perspective to the extent that it is 

determined by objectively stable phenomena and processes. In addition, the main 

methods and models of extrapolation are used. 

There are several classes of software that differ in their functionality and 

technological stages of processing geographic information. 

Software software are distributed on five the main classes used. 

The first, functionally most complete class of software is instrumental GIS. They 

can be designed for a variety of tasks: to organize the input of information (both 

cartographic and attributive), its storage, testing complex information requests, solving 

spatial analytical problems (corridors, environments, network tasks, etc.), construction 

of derivative maps and schemes operations) and for preparation of the conclusion on a 

firm carrier of original models of cartographic and schematic production. Typically, 

GIS tools support work with both raster and vector images, have a built-in database for 

digital basis and attribute information, or support for storing attribute information one 

of the common databases - Paradox, Access, Oracle and others. 

The second important class is the so-called GIS viewers, ie software products 

that provide the use of databases created using instrumental GIS. Typically, GIS 

viewers provide the user (if any) with extremely limited opportunities to replenish 

databases. All GIS viewers include tools for querying databases that perform 

positioning and scaling operations on cartographic images. Viewers are always part of 

medium and large projects, reducing the cost of creating a certain part of jobs that are 

not provided with the rights to replenish databases. 

ESRI's ArcGIS software line stands out among other GIS packages with 

advanced modeling tools based on geodata and spatial analysis. This line is used to 

comprehensively solve large-scale problems of the transport industry. 

Intermodal freight transport is receiving increased attention as congestion, 

environmental and traffic safety issues remain unresolved. The strategic importance of 

speed and ingenuity in securing the supply chain forces firms to reconsider traditional 
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logistics services. As a result, researchers are growing interested in the problems of 

intermodal freight transport. 

The success of many companies depends on the use of transport networks that 

move goods and cargo. GIS is used to solve the problem of transportation, which is 

reduced to finding (finding) the optimal route of transportation by the existing transport 

architecture of the region. The road network can be represented as a high-level spatial 

geometric object, and the task of finding the optimal route is to search on the graph of 

interconnected sections of the network that meet the specified initial conditions. All 

information that affects the selection of links of the route, namely: the attributes of 

cargo, vehicle, transport infrastructure - must also be taken into account. This 

combination of the use of spatial and attributive data is the scope of geographic 

information systems. 

The purpose of the geographic information system of freight is to improve the 

quality of road freight, the efficiency of decisions, the "validity" of the existing routes 

of freight, reducing the number of errors of a subjective nature. 

For each object on the map you can get detailed reference information. It is 

enough to point the mouse to the object of interest - and in the pop-up dialog will appear 

information not only about him but also about other objects within it. 

Thus, in the case of setting different transport parameters, GIS is able to build 

several alternative route options, which can be further evaluated in terms of cost and 

on the basis of the obtained data to decide on the final route. 

In the process of working with the geographic information system, the end user 

accumulates data on successfully constructed routes and the initial conditions for the 

construction of these routes in the knowledge base for further reuse of this information 

under similar conditions. 

In terms of architecture, the most popular and competitive option for developing 

a geographic information system is a geographic information service that allows users 

to work through an Internet browser from personal computers and is an application for 

mobile devices. 
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1 CREATION OF NETWORK DATA SETS AND THEIR ANALYSIS 

 

1.1 Creating a network data set 

  

Network data sets are used to model engineering networks, including transport 

ones. They are created from initial objects, which can consist of simple objects (lines 

and points) and turns, as well as maintain the connectivity of the original objects. All 

types of analysis with the simultaneous use of the optional module ArcGIS Network 

Analyst extension are performed using a set of network data. 

The network data set simulates the street network shown in Figure 1.1. The 

figure shows that one-way streets, turn restrictions and overpasses / tunnels can be 

simulated. Network analysis operations, such as point-to-point route search, are 

performed based on the properties of the network data set. To understand the meaning 

and importance of the concept of connectivity, it should be borne in mind that objects 

usually do not contain information about the existence of each other. For example, if 

two linear objects intersect, neither line contains information about them. Similarly, a 

point object at the end of a linear object does not contain specific information about 

that line, but the network data set contains information about which initial objects 

match. The network data set is characterized by connectivity that can be changed to 

determine which of the matching objects are really connected. As a result, it is possible 

to model tunnels and overpasses in the absence of communication between roads. Thus, 

when performing network analysis, the calculation mechanisms contain information 

about which simulation tools can be applied to a particular network. 

To create a set of network data in the geodatabase, you must use the objects 

"Turns" and "Streets" (Kharkov). You also need to include traffic history data to 

calculate time-bound routes. 

Determine the sequence of operations to create network data from geographic 

information about the city of Kharkiv. To do this, use ArcGIS software and ESRY's 

ArcCatalog module. 
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The software selected for operation is provided by ESRY for use in the 

educational process. 

Let's define kinds of technological works and their order concerning 

geoinformation data for creation of a set of network data. 

1. Activate the optional ArcGIS Network Analyst module by running the 

following actions: 

a) click on Settings(Customize)> Additional modules (Extensions); the 

Extensions dialog box opens. 

b)  mark ArcGIS Network Analyst; 

c) click Close;   

2. On the Standard toolbar, click Connect To Folder . 

The Connect to Folder dialog box opens. 

3. Go to the folder with updated geo-information materials about the city of 

Kharkiv with materials from the Network Analyst module. 

The shortcut for this folder will be added to the Catalog Tree under the Folders 

Connection heading. 

4. In the Catalog Tree, expand the node ... \…> Kharkiv.gdb. 

5. Click on the Transportation feature set. 

The feature classes contained in the feature class set are listed on the Contents 

tab in ArcCatalog. 

6. Right-click the Transportation and New> Network Dataset feature sets. 

 

Figure 1.1 
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The New Network Dataset wizard opens. 

Note. To open the New Network Dataset wizard in the geodatabase, right-click 

the feature class set that contains the source feature classes (such as streets) and choose 

New (New)> Network Dataset ). To create a network data set using a shapefile, right-

click the Street shapefile itself (not the workspace that contains the shapefile) and 

choose New> Network Dataset. 

The reason for the difference is that geodatabase networks allow the use of 

different sources stored in a feature class set to create a multimodal network, while 

shapefile network datasets can handle only one source feature class. 

7. Enter Streets_ND as the name of the network data set (Figure 1.2). 

  

  

  

Figure 1.2 

The Select a version for your network dataset option must be set to the latest 

version. 

This option is convenient for hosting a set of network data for access by users 

using earlier versions of ArcGIS. They will be able to open a network dataset created 

and shared for public if a version number less than or equal to their ArcGIS version 

number is selected. The disadvantage of this choice is that the new network data set 

cannot include the functionality that appeared in the new versions of ArcGIS - the 

controls for adding these functions in the New Network Dataset wizard will be inactive. 

If you do not need to share the network data set, or if the users who will have access to 

it have the same versions of ArcGIS, it would be wise to choose the latest version. 

8. Click Next. 

9. Install parameter class objects Streets, to use it as a source for a network 

data set. 
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10. Click Next. 

11. Click Yes to simulate network turns. 

12. Check Restricted Turns to use this source of rotation objects. The 'Global 

Turns' option must already be checked. By default, it allows you to add default 

penalties for turns (Fig. 1.3). 

  

Figure 1.3 

13. Click Next. 

14. Click Connectivity. 

The Connectivity dialog box opens. Here you can set the network connectivity 

model. 

For a certain class of "Streets" objects, streets are connected to each other at end 

points. 

15. Make sure Streets is set to End Point. 

16. Click OK to return to the New Network Dataset wizard. 

17. Click Next. 

18. This dataset has altitude fields, so make sure that the Use Elevation Fields 

option is selected. 

Relief settings in the network data set further determine network connectivity. 

Let's show it by an example. Suppose that two edges have endpoints that coincide in 

coordinates X, Y, but their heights are different: one endpoint is located above the 

other. In addition, assume that the connectivity function is set for Endpoints. If the 
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heights of the points do not matter, the edges are connected. On the other hand, if the 

heights are taken into account, they will not connect. 

There are two ways to model the terrain: using the true values of the heights of 

geometry or using logical values of heights in the fields of heights. 

The Street object class has logical elevation values stored as integers in the ID 

fields. If, for example, two coincident endpoints have a field height value of 1, then the 

edges are connected. However, if one of the endpoints is 1 and the other matching point 

is 0 (zero), the edges do not connect (match). Network Analyst recognizes field names 

in this dataset and automatically assigns them to the map, as shown in Figure 1.4 (The 

height field function can only be performed with integer fields). 

  

  

  

Figure 1.4 

19. Click Next. 

The page for configuring network attributes will look like this (Fig. 1.5). 
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Figure 1.5 

Network attributes are network properties that describe navigation in a network. 

Typical examples are cost attributes that act as impedances in a network and restriction 

attributes that prohibit passage in both or one direction (for example, if roads are one-

way). 

Network Analyst analyzes the source classes of spatial objects for standard 

fields, such as Meters, Minutes (FT_Minutes, and TF_Minutes, depending on the 

direction) or One way. If such fields are detected, the corresponding network attributes 

associated with these fields will be automatically created (the results of this process 

can be seen by clicking on Evaluators). 

You need to add some network attributes yourself. 

20. Click Add. 

The Add New Attribute dialog box opens 

21. Enter Meters in the Name field. 

22. For Usage Type, select Cost. 

23. For Units, select Meters. 

24. Leave the Data Type Double (Fig. 1.6). 
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Figure 1.6 

25. Click OK (Figure 1.7). 

  

 

Figure 1.7 

26. Click the Meters bar to select, then click Evaluators to set how the network 

attribute values are defined. 

The Evaluators dialog box opens. 

27. Next, you need to click on the Type column and select Field, then on the 

Value column and select LENGTH (Fig. 1.8). 
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Figure 1.8 

28. Click OK. 

29. Click Add. 

It will open dialogwindow Addition new attribute. 

30. Enter Minutes in the Name field. 

31. For Usage Type, select Cost 

(Cost). 

32. For Units, select Minutes 

33. Leave the Data type Double (Fig. 1.9). 

  

 

Figure 1.9 

34. Click OK. 
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35. Click the Minutes bar to select, then click Evaluators to see how the 

network attribute values are defined. 

The Evaluators dialog box opens. 

36. Next, click on the Type column and select 

Field, then the Value column and select LENGTH (Fig. 1.10). 

  

 

Figure 1.10 

37. Next you need to go to the Default Value, in the Elements Rotate mark 

Type instead of Constant - Allow global turns  (Fig. 1.11). 

 

Figure 1.11 

38. Click Apply, and then click OK. 
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39. Click Add. 

The Add New Attribute dialog box opens. 

Enter One way in the Name field. 

40. For Usage Type, select Restriction. 

41. Leave the Data Type Prohibited (Fig. 1.12). 

  

  

Figure 1.12 

42. Click OK. 

43. Click Add. 

It will open dialogwindow Addition new attribute. 

44. Enter Road Class in the Name field. 

45. For Usage Type, select Descriptor. 

46. For Units, select Uknown. 

47. Select Data type Integer (Fig. 1.13). 

  

  

Figure 1.13 
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48. Click OK. 

49. Click Add. 

50. The Add New Attribute dialog box opens. 

51. Enter Travel Time in the Name field 

52. For Usage Type, select Cost. 

53. For Units, select Minutes. 

54. Leave Data type Double, check Use default (Fig. 1.14). 

  

Figure 1.14 

55. Click OK. 

56. Click Travel Time to select, then click Evaluators to set how network 

attribute values are defined. 

57. The Evaluators dialog box opens. 

58. Next you need to click on the Type column and select Field, then on the 

Value column and select LENGTH (Fig. 1.15). 

  

Figure 1.15 
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59. Next you need to go to the Default Value (Default Value), in the Elements 

(Elements) Rotate mark Type instead of Constant - Allow global turns (Allow global 

turns) (Fig. 1.16). 

  

  

Figure 1.16 

60. Click Apply, and then click OK. 

61. Click Add. 

The Add New Attribute dialog box opens. 

62. Enter Weekday Fallback Travel Time in the Name field. 

63. For Usage Type, select Cost. 

64. For Units, select Minutes. 

65. Leave the Data type Double, check Use default (Fig. 1.17). 

  

Figure 1.17 

66. Click OK. 
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67. Click the Weekday Fallback Travel Time bar to select, then click 

Evaluators to set how network attribute values are defined. 

68. The Evaluators dialog box opens. 

69. Next you need to click on the Type column and select Field, then on the 

Value column and select LENGTH (Fig. 1.18). 

  

Figure 1.18 

70. Further necessary to go to (Default Value), in Elements, select 

Type instead of Constant - Allow global turns (Fig. 1.19). 

 

Figure 1.19 

71. Click Apply and click OK. 

72. Click Add. 
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The Add New Attribute dialog box opens 

73. Enter WeekendFallbackTravelTime in the Name field. 

74. Select the value for Usage Type Cost (Fig. 1.20). 

75. For Units, select Minutes. 

76. Leave the Data type Double, check the Use default (Fig. 1.20). 

  

Figure 1.20 

77. Click OK. 

78. Click the Weekend Fallback Travel Time bar to select, and then click 

Evaluators to set how network attribute values are defined. 

The Evaluators dialog box opens. 

79. Next you need to click on the Type column and select Field, then on the 

Value column and select LENGTH (Fig. 1.21). 

  

Figure 1.21 
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80. Next, you need to go to the Default Value (Default Value), in the Elements 

(Elements) Rotate mark Type instead of Constant - Allow global turns (Allow global 

turns) (Fig. 1.22). 

  

Figure 1.21 

81. Click Apply and OK. 

82. Click Add. 

The Add New Attribute dialog box opens. 

83. Enter RestrictedTurns in the Name field. 

84. For Usage Type, select Restriction. 

85. Leave Prohibited for Restriction Usage. 

This setting prohibits the intersection of rotation objects during analysis. 

86. Note that the Use by Default option must be enabled. This constraint is 

used by default when creating a new network analysis layer. If you want to ignore the 

limitations when performing the analysis, enable it in the analysis settings (Fig. 1.23). 

  

Figure 1.23 
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87. Click OK. 

New attribute Restricted rotations added to the attribute list. A blue circle with 

the letter D inside indicates that the attribute is enabled by default in new analyzes. 

88. Click Evaluators to assign a source value to the new attribute. 

89. To set the rating type for the Restricted Turns attribute to Constant, follow 

these steps: 

a) In the Attribute list, select Restricted Turns; 

b) In the Restricted Turns line, click under the column 

on Type and select Constant from the drop-down list; 

c) Click on the Value column and select Use Restriction. 

  

The result should look like this (Fig. 1.24): 

 

Figure 1.24 

After that, by default, Network Analyst will not manage any of the objects in the 

Restricted Turns object class. This technique is a good way to simulate incorrect or 

dangerous turns that should be avoided. Estimates for street sources have not been set, 

so they will remain passable when using Restricted Turns. 

91. Click OK to return to the New Network Dataset wizard. 

The result should be as follows (Fig. 1.25): 
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Figure 1.25 

  

92. Click Next. 

93. In the Mode of movement value, enter Streets. 

94. Under Type, select Automobile. 

95. In the Impendace value, select Meters. 

96. In the Attribute time value, select Travel Time (Fig. 1.26). 

  

 

Figure 1.26 
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97. Click Next. 

98. To adjust the track sheet, click Yes (Figure 1.27). 

  

Figure 1.27 

99. Click on Directions. 

The Network Direction Properties dialog box opens. 

Now you need to specify the fields for the travel letter, which belongs to the 

results of network analysis. 

100. Make sure the Name field is on the General tab (Name) Primary lines are 

automatically associated with the Name_RUS element. 

The Name field (NAME_RUS) contains the names of the streets of Kharkiv 

needed to generate directions. 

The result should look like this (Fig. 1.28): 

 

Figure 1.28 
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Click Apply and click OK. 

101. Click Next. 

102. Click Next. 

103. Click Finish. 

104. Click Yes. 

After creating the network, the system will issue a request to build it. In the 

process of construction, the connected elements of the network are defined and the 

attributes of the network data set are filled. Network construction is applied before 

performing any network analysis operations. 

105. Click Yes. 

  

The Build Network Dataset process indicator will appear, it will disappear after 

the build process is completed (Fig. 1.29). 

  

 

Figure 1.29 

A new network data set (Streets_ND) has been added to the directory 

ArcCatalog simulta neously withclass objects system nodes Streets_ND_Junctions. 

103. You can preview a set of network data by clicking on the name of the set 

and then on the Preview tab. 

The ribs will be displayed, and then traffic will be assigned. 

104. Close the ArcCatalog. 

The created set of network data meets certain requirements, it can be added to 

ArcMap and used for network analysis. 
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1.2 Creating a multimodal network data set 

  

In addition to these methods, connectivity is provided by creating multimodal 

transport networks. The network data set also includes many network attribute models, 

which allows you to model the impedance, constraints and hierarchy of the network. 

In ARC / INFO, coverage was used to quickly create networks. In ArcView GIS, 

during the first network analysis, a permanent network was created for the linear 

shapefile. In ArcGIS, a persistent network is stored in a network dataset. You can save 

this network, change its properties, or simulate other networks using network datasets. 

There are several ways to create a network data set. It is best to create a network data 

set from object classes in the geodatabase object data set. Because an object data set 

can be stored and interact seamlessly with multiple classes of spatial objects, a network 

data set can support multiple sources and simulate a multimodal network. Shapefile-

based network datasets allow ArcView GIS users to transfer data quickly. A shapefile 

network data set is created from a polyline shapefile file that contains a network source 

(such as a street network) as well as a shapefile spatial object class. This set of network 

data does not support multi-edge sources. It also cannot be used to model multimodal 

networks. The ArcGIS Network Analyst extension plug-in can read SDC network 

datasets. This allows you to perform network analysis of SDC data provided by the 

provider without the need to create your own set of network data. 

We will describe the technology of creating a multimodal set of network data for 

the transport network of Kharkiv. To do this, we use geographical information about 

the streets and intersections of the city, as well as subway lines, and obtain data for 

multimodal analysis. 

Let's start the network data set wizard. 

1. Activate the ArcGIS Network Analyst plug-in by following these steps: 

a) click on Settings(Customize)> Additional modules (Extensions). The 

Extensions dialog box opens; 

b) mark ArcGIS Network Analyst; 

c) click Close. 
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2. If you have not already been connected to the Network Analyst Wizard 

folder, you need to get up by following these steps: 

a) on the Standard toolbar, click the Connect To Folder button . A dialog box 

opens Connect To Folder; 

b) go to the folder with the materials of the Network Analyst module; 

c) click OK. 

The shortcut for this folder will be added to the Catalog Tree under the Folders 

Connection heading. 

3. IN Trees catalog (Catalog Tree)  deploy the node... \…> 

Kharkivgdb. 

4. Click on the Transportation feature set. 

The classes of spatial objects contained in it are listed on the Contents tab in 

ArcCatalog. 

5. Right-click the Transport feature set (Transportation) and New> Network 

Dataset (Fig. 1.30). 

  

  

Figure 1.30 
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The New Network Dataset wizard opens. 

The name of the network and the choice of source classes of spatial objects 

Steps: 

1. Enter Kharkiv Multimodal as the network dataset name (Fig. 1.31). 

 

Figure 1.31 

The Select a version for your network dataset option must be set to the latest 

version. 

This option is useful when hosting network datasets for users who have earlier 

versions of ArcGIS. They will be able to open a network dataset created and shared for 

public if a version number less than or equal to their ArcGIS version number is 

selected. The disadvantage of this choice is that the new network data set cannot 

include the functionality that appeared in the new versions of ArcGIS, because the 

controls for adding these functions in the New Network Dataset wizard will be inactive. 

If you do not need to share the network data set, or if users who have access to it have 

the same versions of ArcGIS, it is best to choose the latest version. 

2. Click Next. 

A wizard page appears to select the feature classes that participate in the network 

data set. 

3. Click on Choose all (Select All)  for choice all classes of spatial objects 

so that they perform the function of sources in the network (Fig. 1.32). 
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Figure 1.32 

  

4. Click Next. 

5. Click Yes to simulate network turns. 

6. Although there are no rotation object classes for this network, selecting 

Yes allows the network data set to support shared rotation and allows rotation objects 

to be added at any time after the network is created. 1.33). 

  

 

Figure 1.33 

7. Click Next. 

The connectivity setup page is displayed. 
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Connectivity settings and terrain rules 

The connectivity settings in the ArcGIS Network Analyst plug-in start with 

defining connectivity groups. The sources of the edges are determined relative to one 

or more groups of connectivity. The connectivity group can contain any number of 

sources. The connection of network elements is determined by the connectivity group 

of the element. For example, two edges created from two separate source object classes 

can be connected if they belong to the same connectivity group. If the edges belong to 

different connectivity groups, then the edges to be connected are not joined by a 

connection that participates in both connectivity groups. 

Connectivity groups are created by following these steps: 

1. Click Connectivity to configure the network connectivity model; the 

Connectivity dialog box opens. 

2. Click once on the up arrow on the Group Columns to increase the number 

of connectivity groups to two. The column for the second connectivity group is created 

in the Connectivity Groups table. In this exercise, the connectivity group (1) is the 

metro system and the group (2) is the street network. 

3. Click on the Streets line (Streets2001_1) and check the column labeled 2 

to move the street source to connectivity group (2) (Figure 1.34). 

 

Figure 1.34 

  

4. Click OK to return to the New Network Dataset wizard. 
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5. Click Next. 

Terrain settings in the network data set further determine network connectivity. 

Let's show it by an example. Suppose that two edges have endpoints that coincide in 

coordinates X, Y, but have different heights (one endpoint is located above the other). 

In addition, assume that the connectivity method is set for Endpoints. If the heights of 

the points do not matter, the edges are connected. On the other hand, if the heights are 

taken into account, they will not connect. 

There are two ways to model the terrain: using true values of geometry heights 

or using logical values of heights in height fields. 

6. There is no terrain data for this data set, so you need to click on None (Fig. 

1.35). 

 

Figure 1.35 

7. Click Next (Fig. 1.36). 
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Figure 1.36 

8. Click Add. The Add New Attribute dialog box opens. 

9. Enter Meters in the Name text box. 

10. Set the Usage Type to Cost. 

11. Change Units to Meters. 

12. Set the Data Type to Double Precision Number. 

 

Figure 1.37 

13. Click OK (Fig. 1.38). 

 

Figure 1.38 
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14. Click Add. 

15. Enter Minutes in the Name text box. 

16. Set the Usage Type for Cost. 

17. Change Units to Minutes. 

18. Set the Data Type to Double Precision Number (Figure 1.39). 

 

Figure 1.39 

19. Click OK. 

20. Click Add. The Add New Attribute dialog box opens. 

21. Enter Oneway in the Name field. 

22. For Usage Type, select Restriction. 

23. Leave the Data Type Prohibited (Fig. 1.40). 

  

 

Figure 1.40 

24. Click OK. 

25. Click Add. The Add New Attribute dialog box opens. 

26. Enter RoadClass in the Name field. 
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27. For Usage Type, select Descriptor. 

28. For Units, select Uknown. 

29. Click Integer Data Type (Figure 1.41). 

  

 

Figure 1.41 

30. Click OK. 

The wizard displays the attributes of the network data set (Fig. 1.42). 

  

  

Figure 1.42 

  

Verify and create network attributes 

The purpose of this network data set is to simulate travel time on foot and by car. 

This will allow you to choose one of two values based on time spent when performing 

online analyzes. For example, you can answer the question of which route from point 

A to point B is the shortest for a pedestrian walking on the streets and taking the 



35 

 

subway, or which route is the shortest for a person traveling by car. To perform this 

task, you must configure attributes for two time values: Pedestrian Time and Drive 

Time. 

Steps: 

1. The Minutes attribute, which Network Analyst automatically identifies in 

the source data, indicates the time of the trip, so you can change its name to a clearer 

one. 

2. Select the Minutes line, click Rename, enter the Drive Time and press 

ENTER (Fig. 1.43). 

  

 

Figure 1.43 

Next you need to create the Pedestrian Time attribute. 

3. Click Add. The Add New Attribute dialog box opens. 

4. Enter PedestrianTime in the Name text box. 

5. Set the Usage Type for Cost. 

6. Change Units to Minutes. 

7. Set the Data Type to the Double Precision Number (Fig. 1.44). 

  

  

Figure 1.44 

8. Click OK. 
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9. The Add New Attribute dialog box closes, and Pedestrian Time is added 

to the attribute list. 

The three cost attributes, Meters, Drive Time, and Pedestrian Time, are marked 

with yellow symbols to warn of potential problems with valuation features that 

determine how network attribute values should be calculated. 

The following three sections describe the evaluation setup process. 

  

Meter evaluation settings 

This section and the following sections describe the process for setting up 

estimates. The Meters calculates the distance value for the edges of the network, thus 

determining the length of the edge. 

Steps: 

1. Click on Meters and click on Evaluators (Fig. 1.45). 

  

 

Figure 1.45 

The Evaluators dialog box opens. It allows you to view or edit the type of 

evaluation and its value for each source on the network. It is clear that the sources of 

connections and turns always have one related evaluation function, while the sources 

of edges - two: one for each direction of movement (directions "from - to" and "to - 

from"). 
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2. While holding down the SHIFT key, click on the lines citybrdr From - To 

(From - To) and then click on the term citybrdr To - From, metro_l (From - To) 

and metro_l To - From, streets2001_1 (From - To); then click on the term 

streets2001_1 (To - From), T02_polyline_1 (From - To); on the term T02_polyline_1 

(To - From), metro_1 (From - To); further on the term subway_1 (To - From). 

Eight lines with warning symbols will be selected. 

3. Right-click on any of the selected rows and select Type> Field (Fig. 1.46). 

 

Figure 1.46 

Warning symbols change to red error symbols, which indicate incomplete 

assignment of values by field estimates. 

4. Without deselecting eight lines, right-click on one of them on the side of 

the fields and select Value> SHAPE_LENGTH (Fig. 1.47). 

 

Figure 1.47 
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This assigns values from the SHAPE LENGTH field in the selected source 

feature classes for the Meters attribute relative to the associated edge elements of the 

network. 

5. Click the Apply button. 

6. The Meters network attribute is configured to obtain a length value. 

  

Configure the Drive Time evaluation function 

(Travel by car) and One way (One way) 

  

Because cars only move on the streets, estimates for different sources need to be 

adjusted accordingly. 

Steps: 

1. In the Attribute list, select Drive Time. 

Drive Time values for the Street source were automatically set by Network 

Analyst, but other edge sources are marked with warning symbols because their values 

have not been set. These sources should be marked as limited. In addition, metro 

stations should be limited in such a way as to prevent the location of new network 

analysis facilities in their area. 

2. Click Evaluators. 

3. Use the CRTL key to select streets2001_1 From-To and streets2001_1 

(To-From), click Type and select Field, and select LENGTH (Figure 1.48) and Value. 

 

Figure 1.48 
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4. Select all the last rows by clicking on one of the rows, and while holding 

down the CTRL key, select the other rows by clicking 

(Fig. 1.49). 

 

Figure 1.49 

5. Right-click on any of the selected rows and on the constant Type> 

Constant. 

6. Right-click one of the selected rows again, but this time Value> 

Properties. 

The Constant Value input window appears. 

7. Type -1 and click ENTER. 

The values for all selected rows change to -1. Network Analyst considers all 

items with a value of -1 limited. Whenever the Drive Time attribute is used as an 

impedance in network analysis, these sources are impassable (Fig. 1.50). 
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Figure 1.50 

8. Click Apply, and then click OK. 

The One way attribute is weakly related to the Drive Time attribute, because it 

simulates the one-way traffic restrictions that drivers are required to adhere to. Later, 

in the process of conducting an analysis using Drive Time as a cost, it is necessary to 

enable the One way constraint, so that one-way streets are taken into account during 

route formation. On the other hand, one way restrictions cannot be used when modeling 

pedestrian traffic, as pedestrians can move in any direction. 

  

Pedestrian Time Estimation Settings 

  

The Pedestrian Time network attribute indicates the time in the network that a 

pedestrian spends on the road. At this stage, it is necessary to assign an appropriate 

travel time for a pedestrian who can travel on the subway or move through the streets. 

Steps: 

1. From the Attribute list above the dialog box, select Pedestrian Time, and 

then click Evaluators. 
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2. Select two citybrdr values (citybrdr To-from, citybrdr From-to), right-

click on one of the selected rows and in the field Type (Field)> Field (Field), and in 

the Value column, select CITYBRDR_I 

(Fig. 1.51). 

  

 

Figure 1.51 

3. Select two metro_l values (metro_l To-from, metro_l From-to), right-click 

on one of the selected rows and in the field Type> Constant> Constant, and in the value 

column (Value) select 0 (Fig. 1.52 ). 

  

 

Figure 1.52 

4. Select the two values streets2001_1 (streets2001_1 To-from, 

streets2001_1 From-To), right-click on one of the selected rows and the field Type> 

Field (Field), and in the column Value, select LENGTH (Fig. 1.53 ). 

  

 

Figure 1.53 

5. Select two values T02_polyline_1, right-click on one of the selected rows 

and the field Type> Field (Field), and in the column Value (Value) select ID (Fig. 

1.54). 

 

Figure 1.54 

6. Select two values of metro_1, right-click on one of the selected rows and 

in the field Type (Type)> Constant (constant), and in the column Value (Value) select 

0 (Fig. 1.55). 
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Figure 1.55 

The result should be as follows (Fig. 1.56): 

  

 

Figure 1.56 

7. Click the From Streets line to select it. Hold down the CTRL key, click 

the Streets To-From line to select both lines. 

8. Right-click on one of the selected rows and on Value >> Properties. 

The Field Evaluators dialog box opens. 

For Streets, Pedestrian Time is the walking time. Assume that the pedestrian 

speed is 3 km / h, the travel time in minutes will be [LENGTH] * 60/3000, where 

[LENGTH] is an attribute containing the length of the rib in meters. 

9. Double-click the LENGTH field to move it to the Value = text box, and 

enter the expression [LENGTH] * 60/3000 in the Field Evaluators dialog  

box (Figure 1.57). 
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Figure 1.57 

10. Click the Verify button to make sure the expression is correct and correct 

it if necessary. 

11. Click OK to return to the Ratings dialog box (Evaluators) (Fig. 1.58). 

 

Figure 1.58 
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12. Click OK to return to the New Network Dataset wizard. 

13. Click Next. 

14. In the Mode of movement, enter Streets. Press ENTER. 

15. Select Automobile as the Type value. 

16. Select Meters as the Impendace value. 

17. Select Drive Time as the Attribute time value (Figure 1.59). 

  

 

Figure 1.59 

18. Click Next. 

  

Setting directions 

After calculating the routes in the selected network data set, you can determine 

the direction of travel to track the results. The network data set must have at least one 

edge source with a text attribute (for street name information) and a distance attribute 

to determine the distance to which the next maneuver is to be performed. 

Steps: 

1. Click Yes to adjust the track sheet. 

2. Click on Directions. The Network Direction Properties dialog box opens. 
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3. Specify fields for compiling a travel letter, which is one of the results of 

network analysis. On the General tab, in the Source list, select Streets2001_1 (Figure 

1.60). 

  

  

Figure 1.60 

4. In the Street Name Fields list, click Primary to select. 

5. Click on the Name column and select Name_RUS 

(Fig. 1.61). 

  

Figure 1.61 

6. Click OK to return to the New Network Dataset wizard. 

7. Click Next. 

8. Click Next. 
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This will display summary information for all settings. 

Creating and building a network data set 

After setting the values required for the network data set to function, you need 

to create and build the set. The creation process is fast and usually creates a container 

for the logical network. 

Steps: 

1. Click Finish. 

A process indicator will appear, which allows you to monitor the process of 

creating a set of network data in the Network Analyst module (Fig. 1.62). 

  

Figure 1.62 

After creating the network, the system will issue a request to build it. In the 

process of construction, the connected elements of the network are defined and the 

attributes of the network data set are filled. You need to build a network before 

performing any network analysis operations. 

2. Click Yes. 

The Build Network Dataset process indicator will appear (Fig. 1.63); after the 

construction process it will disappear. 

  

Figure 1.63 

A new set of network data - KharkivMultimodal_ND has been added to the 

ArcCatalog at the same time as the spatial object class of the 

KharkivMultimodal_ND_Junctions system nodes. 

You can preview a set of network data by clicking on the name of the set and 

then on the Preview tab. 

3. Close the ArcCatalog. 
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1.3 Search for the optimal route using a set of network data 

  

This section clarifies the solution of the problem of constructing the shortest 

route from the starting and intermediate points in the city of Kharkiv. 

1. Activate the ArcGIS Network Analyst plug-in by running 

the following actions: 

a) click on Settings (Customize)> Additional modules (Extensions). The 

Extensions dialog box opens; 

b) mark ArcGIS Network Analyst; 

c) click Close. If the Network Analyst toolbar isn't already displayed, you'll need 

to add it; 

2. Click Customize> Toolbars> Network Analyst. 

The Network Analyst toolbar will be added to ArcMap (Figure 1.64). 

  

 

Figure 1.64 

3. If the Network Analyst window does not yet appear, you need to add it. 

On the Network Analyst toolbar, click the Network Analyst window . 

The attached Network Analyst window will open (Fig. 1.65). 

  

Figure 1.65 

The Network Analyst window can be pinned and unpinned. 
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Create a route analysis layer 

Click Network Analyst on the Network Analyst toolbar and click New Route 

(Figure 1.66). 

  

 

Figure 1.66 

The route analysis layer will be added to the Network Analyst window. Classes 

of network analysis: Stops, Routes, Point Barriers, Line Barriers and Polygon Barriers 

are empty (Fig. 1.67). 

  

  

Figure 1.67 

  

Also, a new layer of analysis has been added to the Table Of Contents window 

(Fig. 1.68). 
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Figure 1.68 

  

Add a stop Then you need to add the necessary stops of the route. 

Steps: 

1. In the Network Analyst window, click Stops (0). 

The choice of stop means that it is placed in the active class of network analysis. 

2. On the panel tools Network Analyst click on the map Create Network 

Location Tool . 

You can add network analysis objects to the active network analysis class by 

clicking on the Create Network Location Tool map. 

3. Click anywhere on the street network to determine the new location of the 

stop (Fig. 1.69). 

  

  

Figure 1.69 
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Network Analyst calculates the nearest network location and marks the stop with 

the Located symbol. The stop remains selected until another stop is placed that is 

unselected. 

The located stop also displays the number 1. All stops are marked with unique 

numbers that make up the order in which the stops are located along the route. It should 

be noted that in the list of the Stops class in the Network Analyst window, one stop is 

specified (Fig. 1.70). 

  

  

Figure 1.70 

  

4. Add two more stops anywhere on or near the streets (Fig. 1.71). 

 

 Figure 1.71 
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 New stops are assigned numbers 2 and 3. The first stop is considered as a 

starting point, and the last - as a destination (Fig. 1.72). 

  

  

  

Figure 1.72 

  

You can change the sequence of stops by clicking the stop number on the 

Network Analyst window and moving it to another position in the list. 

If the stop is not placed on the network, it will be displayed with the symbol "not 

aligned" (however, using the default settings, you must place the stop more than 5 

kilometers from the nearest segment of the street so that it is not considered located  

in Fig. 1.73). 

  

  

Figure 1.73 

  

An unplaced stop can be moved closer to the network so that it is located. If the 

stop on the network is placed incorrectly, you can move it to the correct position. 

To move a stop, follow these steps: 
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a) click on Select / Move tool Network Position (Select / Move Network 

Locations Tool) on the toolbar Network Analyst; 

b) click on the stop to select it; 

c) click on the stop again and drag it to a new place (Fig. 1.74). 

  

  

Figure 1.74 

  

Setting analysis parameters 

Next, it is necessary to specify that the route will be calculated on the basis of 

travel time (minutes), that turns can be made arbitrarily, and it is necessary to adhere 

to one-sided restrictions and restrictions on turning. 

Steps: 

1. Click the Analysis Layer Properties button in the Network Analyst 

window (Fig. 1.75). 

  

  

Figure 1.75 

The Layer Properties dialog box opens. 

2. Click the Analysis Settings tab. 

3. Make sure that Impedance is defined as Travel Time (Minutes)  

(Figure 1.76). 
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Figure 1.76 

  

This network dataset has a traffic history associated with the TravelTime 

(Minutes) attribute. If you enter a start time (select Use Start Time and fill in the three 

fields below it), Network Analyst will search for the optimal route time based on the 

specified time of day and speed of traffic history. Otherwise, the program will search 

for the optimal route in time by the function of street lengths and speed limits. 

4. Check Use Start Time, enter a specific time and date or day of the week 

by following these steps: 

a) As Time of Day, enter the time when you want to leave the first one stop; 

b) select either the Day of Week or the Specific Date. 

If Day of Week is selected, specify any day from Monday to Sunday; you can 

also select Today to use the current system settings. 

If Specific Date is selected, enter the date in the text box or drop-down list, open 

the calendar, and select the desired date. 

Do not select the Use Time Windows option. 

You can specify temporary windows for stops, in which case Network Analyst 

will search for a route based on the time ranges during which you should visit certain 

stops. 

Do not select Reorder stops to find optimal route. 

If not specified, Network Analyst will calculate the best route with the specified 

sequence of stops. This is the so-called "salesman's task". If this option is selected, the 

program will determine the best route and the best the sequence in which the stops will 

be visited; 

c) select Allowed from the Undo in drop-down list U-Turns at Junctions; 

d) click the Output Shape Type drop-down arrow and select True Shape with 

Measures); 
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e) Make sure that the Use Hierarchy and Ignore Invalid Locations check boxes 

are selected, and that Restricted Turns and One way are checked in the Restrictions 

section. 

f) set that in the Directions frame, the Distance Units parameter has a value of 

Kilometers, the Use Time Attribute item has been selected, and the hour attribute has 

a value of TravelTime (Minutes). 

The Analysis Settings tab might look like this; however, you can turn other 

authorities on the cob Use Start Time (Fig. 1.77).  

  

 

  

Figure 1.77 

g) press OK. 
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Calculation of the most optimal route 

Steps: 

1. Click the Solve button on the Network Analyst toolbar. 

The route object will appear in the map document and in the ArcGIS Network 

Analyst window under the Routes class (Figure 1.78).  

  

 

  

Figure 1.78  

  

If a warning appears, the stop may be on a limited edge. Try moving one or more 

stops with the Network Position Select / Move Tool (Select / Move Network Locations 

Tool) located on the Network Analyst toolbar. 

1. Click the Directions Window button Network Analyst toolbar. 
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The Directions dialog box opens (Figure 1.79). 

 

Figure 1.79 

  

2. Click Close. 
  

Adding a barrier 

To depict an obstacle and find an alternate route to the destination on the route 

you need to add a barrier. 

Steps: 

1. Click Windows> Magnifier. The Magnifier window opens. 

2. Click on the title of the Magnifier window and move it to be located above 

the route (Fig. 1.80). 

 

Figure 1.80 
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3. In the Network Analyst window in the Point Barriers area (0) click 

Restriction (0). 

4. Click the Create Network Position tool (Create Network Location) 

Network Analyst toolbar. 

5. In the Magnifier window, click anywhere on the route to place one or more 

barriers (Figure 1.81). 

 

Figure 1.81 

6. Click the Solve button Network Analyst toolbar. 

We get an alternative route designed to bypass the barrier 

(Fig. 1.82). 

 

Figure 1.82 

7. Close the Magnifier window. 
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Save the route 

  

The route analysis layer is stored in memory, and if you get out of ArcMap 

without saving, the analysis will be lost. However, if you save the map document, the 

analysis layer will be saved with it. You can also export data. One way is to export the 

network analysis layer to a LYR file. Analysis properties and objects are stored in a 

LYR file. Another way is to preserve the analysis sublayers as object classes using the 

Export Data command. The following shows how to export sublayers of routes to a 

feature class. 

Steps: 

1. In the Network Analyst window, right-click Routes (1) and select Export 

Data (Fig. 1.83). 

  

  

  

Figure 1.83 

  

  

The Export Data dialog box opens. 
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2. In the Output feature class text box, enter or specify a location to save the 

results, such as C: \ ArcGIS \ ArcTutor \ Network Analyst \ Tutorial \ Kharkiv.gdb \ 

Exercise3_Route. 

3. Click OK. The route object will be saved in the specified workspace. 

4. Click No to add the exported data to the map as a layer. 

If you do not need to work with other exercises, close the ArcMap application. 

Click No to save the changes. 

If you want to continue working with other exercises, you need to do the 

following: 

a) click on File> New. A dialog box opens New Document; 

b) click OK; 

c) Click No in response to the request to save changes. 

The task of constructing the shortest route from the starting and intermediate 

points in the city of Kharkiv has been solved. 

  

1.4 Analysis of the road network graph 

  

Ensuring the stable functioning of passenger transport systems can be considered 

a priority for transport organizers and carriers. Under certain conditions, providing 

passengers with the opportunity to meet the needs of movement in the most convenient 

way is the basis for the maximum realization of potential transport correspondence 

between the nodes of the transport network. The main factors influencing the actual 

indicators of passenger traffic between the nodes of the transport network can be 

considered: potential correspondence, fare, travel time, time of day, ride comfort, 

regularity and frequency of travel, social and economic characteristics of population 

development in transport hubs. note that the actual indicators of passenger traffic 

should be adjusted according to seasonal or daily fluctuations. 

For its part, the long-distance passenger route transport system uses financial 

resources from transportation to support its activities. The planned inflow of money is 

undoubtedly important for ensuring the stable operation and development of long-
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distance passenger route transport systems. It is equally important to properly distribute 

cash flows between elements of the transport system in time and quantity. Balanced 

movement of financial flows within the system, the quantitative sufficiency of this 

resource and its reasonable use of elements of the system is possible planning and 

development of the industry as a whole. 

The object of study of this section is the state transport network of Ukraine. 

Consider the existing network of roads that form a modern transport network. The 

considered road network consists of more than 70 thousand arches and nodes, which 

describe the routes of interregional, regional, international and regional importance. 

This made it possible to determine the options for the shortest connection of network 

nodes. 

One of the most problematic issues is to improve the quality of transport 

parameters. Scholars have mostly considered the optimization of traffic schedules, the 

choice of rolling stock and determining the optimal routes. Transport networks are part 

of transport systems and provide the ability to transport goods and passengers between 

nodes. At the same time, the peculiarities of the transport network affect the general 

performance of the transport process, namely: the density and intersvity of the flow of 

vehicles, the speed of communication, the length of the ride. 

At the present stage of research to determine the parameters of the functioning 

of transport, many different approaches have been proposed [1]. In [2] it was found 

that the availability of passenger transport correspondence significantly affects the state 

of social and economic development of society. The dependence of transport 

correspondence on routes on social components is described mathematically. In work 

[3] the system of long-distance passenger transport is modeled. In these works, the 

driving distance Lij between points i and j is a factor of resistance to the realization of 

potential correspondence between cities i and j (Hij). 

The author of [4] considers the factors influencing the formation of the cost of 

rail freight. It is established that the length of the freight ride is directly proportional to 

the increase in transportation costs. The work [5] is devoted to the determination of the 

cost and cost of railway transportation, in which the author proves the need to reduce 
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the length of technological races of cars and the current composition to reduce the cost 

of both passenger and freight. 

In [6], the authors provide a definition according to which the transport 

infrastructure is a transport network consisting of nodes and arcs. In [7] it is established 

that the model of the transport network aims to describe transport communications 

(highways and railways, water and air routes) in the form of a connected graph. In 

addition, it is determined that the route network consists of nodes and arcs, and 

sometimes contains routes. Based on these conclusions, the authors of [7] propose to 

describe nodes by points and arcs by polylines and implement such models using 

geographic information systems. In [8] the method of solving the problem of modeling 

transport processes is presented, which, in particular, is based on the theory of graphs 

applied to road networks. As nodes, the authors consider the intersection, end and 

beginning of arcs (streets), 

In [9], the authors propose to analyze transport networks using geographic 

information technologies. The authors of [10] were interested in the results of 

consideration of modern information systems used in engineering networks. In their 

opinion, among the proposed modern systems, the most optimal for use in the 

consideration of engineering measures are automated design systems and geographic 

information systems. Geographic information systems in the analysis of transport 

networks are used by the authors of [11]. The author considers it necessary to combine 

mathematical methods of graph analysis by building geographic information systems 

in the process of planning transport networks and traffic management. The paper [12] 

considers the use of geographic information systems to solve the problems of transport 

in the region. The author of [13] investigated, how the development of the transport 

network affects the economic development of the region, and in [14] the issue of 

assessing the impact of transport infrastructure on the socio-economic development of 

the region is considered. In [15] the expediency of realization of mathematical methods 

of graph reduction by GIS applications during planning of transport networks is 

proved. In [16–19], the authors use GIS tools to estimate the image of the city's route 

network, determining the total length of the network in square kilometers. 
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This section shows how you can automatically determine the center and diameter 

of a graph built with Network Analyst, namely: 

1. Activate the ArcGIS Network Analyst plug-in by following these steps: 

a) clickon Settings(Customize)> Additionalmodules (Extensions). The 

Extensions dialog box opens; 

b) mark ArcGIS Network Analyst; 

c) click Close. 

If the Network Analyst toolbar doesn't appear, you'll need to add it. 

2. Click Customize> Toolbars> Network Analyst. 

The Network Analyst toolbar will be added to ArcMap (Figure 1.84). 

  

 

Figure 1.84 

  

If the Network Analyst window does not appear, you need to add it. 

3. On the Network Analyst toolbar, click the Window button 

Network Analyst (Network Analyst window). The attached Network Analyst 

window will open (Fig. 1.85). 

  

  

Figure 1.85 

The Network Analyst window can be pinned and unpinned. 
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Creating a layer of analysis of the source-destination matrix 

 

You need to create a Source-Destination matrix to determine the center and 

diameter of the graph. This matrix can be used to determine the shortest distances 

between all pairs of vertices, the sum of the shortest distances from one vertex to all 

other vertices, and the center and diameter of the graph. 

Steps: 

Click Network Analyst on the Network Analyst toolbar and the New OD Cost 

Matrix (Fig. 1.86). 

 

Figure 1.86 

  

The Source-Destination matrix analysis layer has been added to the Network 

window 

Analyst Network analysis classes: Origins, Endpoints (Destinations), Lines, 

Point Barriers, Line Barriers and Polygon Barriers are empty (Fig. 1.87). 

  

Figure 1.87 
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Also in the Table of Contents window a new layer of analysis will be  

added (Fig. 1.88). 

  

  

Figure 1.88 

  

Adding origins 

  

Steps: 

1. In the Network Analyst window, right-click Origins (0) and select Load 

Locations. 

The Load Locations dialog box opens (Fig. 1.89). 

2. Click Center in the Load From list. 

3. Click the Only load selected rows check box. 

4. In the Location Position section, click Use Geometry (Figure 1.89). 
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Figure 1.89 

5. Click OK. 

The use of geometry fields allows ArcGIS to use an already located service area 

position to redefine them as a source. This method allows you to redefine your location 

much faster than you can with spatial search. 25 new objects will be displayed in the 

Network Analyst window in the Origins section. 

  

Add appointments 

  

Steps: 

1. In the Network Analyst window, right-click the Destination button 

(Destinations (0))  and choose team Load Locations. 

2. Click Center in the Load From list. 

3. Click the Only load selected rows check box. 
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4. In the Location Position section, click Use Geometry (Figure 1.90). 

 

  

Figure 1.90 

5. Click OK. 

The Network Analyst window will contain 25 objects from the list of 

destinations (Fig. 1.91). 

  

  

Figure 1.91 
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These values will be displayed on the map (Fig. 1.92). 

 

Figure 1.92 

  

Figure 1.92 shows a model of the transport network of Ukraine, which contains 

not only nodes and arcs, but also visualizes cities of regional importance. 

  

Start the process of creating a source-destination matrix 

In the next step, we calculate the Source-Destination matrix by choosing the 

shortest distance between all pairs of vertices. As the route is on the road, it should be 

borne in mind that all incorrect locations (location not found) are ignored. 

Steps: 

1. Click the Solve button Network Analyst toolbar. 

2. Source-Destination lines will be displayed on the map. In this example, it 

is 625 lines (Fig. 1.93). 
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Figure 1.93 

Calculated matrix Source-Purpose, having chosen the shortest 

distance between all pairs of vertices is calculated. 

  

Determination of the diameter of the graph 

In the Network Analyst window, right-click on Lines (625) and select Open 

Attribute Table (Figure 1.94). 

  

  

Figure 1.94 

  

The Lines table opens (Fig. 1.95). 
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Figure 1.95 

  

The Lines table is a Source-Destination matrix. 

To find the diameter of the graph, you need to sort and determine the maximum 

distance (Total_Meters column) from one regional center to another. 

Steps: 

1. Right-click on the name of the column Total_Meters and select the sorting 

method from largest to smallest (Fig. 1.96). 

 

Figure 1.96 
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After sorting, the two distances between regional centers will be the  

same (Fig. 1.97). 

 

 

Figure 1.97 

  

2. Close the table. 

3. Find these distances in the vertex table. To do this, you need to open the 

table of regional centers. 

4. In the Network Analyst window, right-click Center and select Open 

Attribute Table (Fig. 1.98). 
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Figure 1.98 

 

The table of attributes of the regional centers opens (fig. 1.99). 
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Figure 1.99 

  

5. It is necessary to distinguish two regional centers - Simferopol and 

Uzhgorod, as the distance between them is the largest (Fig. 1,100). 

  

 

Figure 1.100 

  

6. Close the table. 

Two vertices are marked on the map, they are considered the most distant  

centers (Fig. 1.101). 
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Figure 1.101 

  

7. Unlock the OD Cost Matrix in the Table Of Contents window to improve 

the visibility of regional centers (Figs. 1.102, 1.103). 

  

  

Figure 1.102 
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Figure 1.103 

  

Draw a route and determine the diameter of the graph. 

  

Create a route layer 

Click Network Analyst on the Network Analyst toolbar and New  

Route (Figure 1.104). 

  

 

  

Figure 1.104 
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The route analysis layer will be added to the Network Analyst window. Classes 

of network analysis: Stops, Routes, Point Barriers, Line Barriers and Polygon Barriers 

are empty (Fig. 1.105). 

  

Figure 1.105 

  

A new layer of analysis will be added to the Table Of Contents  

window (Fig. 1.106). 

  

  

Figure 1.106 

  

Add a stop 

  

Then you need to add the necessary stops of the route Steps: 
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1. In the Network Analyst window, click Stops (0). 

Selecting a stop means that it is in the active network analysis class. 

2. On the panel tools Network Analyst click on the map Create Network 

Location Tool . 

By clicking on the Create Network Location Tool, you can add network analysis 

objects to the active network analysis class. 

3. Click on the two regional centers that are marked on the map of the street 

network to determine the location of the stop (Fig. 1.107). 

 

Figure 1.107 

  

Network Analyst calculates the nearest network location and marks the stop with 

the Located symbol. The stop remains selected until another stop is placed or the 

selection is canceled. 

The located stop displays the number 1. All stops are marked with unique 

numbers that make up the order in which the stops are located along the route. It should 

be noted that in the list of the Stops class in the Network Analyst window, one stop is 

currently specified (Fig. 1.108). 
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Figure 1.108 

  

 

  

Figure 1.109 

  

The first stop is considered the starting point, and the last - the destination. 

4. Click the Solve button  on the Network Analyst toolbar. 

The route object will appear in the map document and in the ArcGIS Network 

Analyst window under the Routes class. 

5. Close the warning window (Fig. 1.109). 

  

Determination of the topological center of the graph 

You must first return to the matrix layer and open the Lines attribute table. 

Steps: 

1. Select the OD Cost Matrix in the Network Analyst window (Fig. 1.110). 
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Figure 1.110 

2. In the Network Analyst window, right-click Lines (625) and select Open 

Attribute Table (Fig. 1.111). 

  

  

Figure 1.111 

  

The Lines table opens (Fig. 1.112). 
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Figure 1.112 

It is necessary to find the center to which the sum of the shortest distances from 

other centers is minimal. To do this, sort the table by OriginID and DestinationID. 

3. Right-click on the Name column and select Advanced  

Shorting (Figure 1.113). 

  

 

Figure 1.113 
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The sorting table opens (Fig. 1.114). 

  

  

Figure 1.114 

4. Select the OriginID column in the Short by row, and change the value of 

Descending to Ascending. In the line Then sort by select DestinationID (Fig. 1.115). 

  

Figure 1.115 

  

Thus, the table is sorted by OriginID and DestinationID columns (Fig. 1.116). 
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Figure 1.116 

  

5. Use the Dissolve command to add the entire distance. 

Click the Geoprocessing button on the ArcMap main panel and select Dissolve. 

The Dissolve window opens (Fig. 1.117). 

  

 

Figure 1.117 
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6. In the Input Features field, select Lines, and then in the Dissolve_Field (s) 

window, select OriginID. 

7. Select Total_Meters in the Statistics Field and Sum in the Statisic Type 

column. 

The Output Feature Class field is responsible for storing the topological center 

of the graph. The topological center of the graph is stored under the name 

ODLines_Dissolve. The Dissolve window should look like this (Fig. 1.118): 

 

Figure 1.118 

8. Click OK. 

9. A new layer called ODLines_Dissolve has been added to the Table Of 

Contents window. 

In the Table Of Contents window, click a new layer ODLines_Dissolve and 

select the Attribute Table command (Fig. 1.119). 

  

Figure 1.119 
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10. Next, you need to find the minimum amount on the attribute table. 

Right-click on the column name SUM_Totatl_Meters and select sort from 

smallest to largest (Sort Ascending) (Fig. 1.120). 

  

Figure 1.120 

The sums of distances of regional centers from the minimum to the maximum 

are sorted. 

11. Select the first line (Fig. 1.121). 

  

  

Figure 1.121 
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12. Close the table. 

The defined regional center is the topological center of the graph (Fig. 1.122). 

  

  

Figure 1.122 

  

If you do not want to continue, close the ArcMap application. 

Click No to save the changes. 
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2 SIMULATION OF TRANSPORT TASKS 

  

2.1 Modeling of optimal trajectories between network objects 

  

Route modeling is one of the main tasks of transport. Such tasks are solved if, 

for example, you need to choose a store to meet household needs. At the subconscious 

level, each of us chooses a store that not only meets the conditions of the possible 

realization of the need to make purchases, but also is located in the most convenient 

place. The requirements for such a location are remoteness and travel time [20-24]. 

Similar needs for planning similar tasks are observed when identifying facilities 

for assistance that are located in the most advantageous places. The needs of the 

population to travel by taxi are also met by solving similar problems. 

This section offers a sequence of actions in ArcMap software. The aim is to 

identify objects located in the network that meet the requirements of users. Such 

requirements are the proximity of objects and the estimated travel time to them in the 

network. The result of this work were models of the proposed routes from the user to 

the objects, built taking into account the constraints. To ensure such modeling, the road 

network of Kharkiv was used [25–29]. 

Steps: 

1. Start ArcMap, select Start> All Programs> ArcGIS> ArcMap 10.5. 

2. In the ArcMap dialog box Getting Started (ArcMap – Getting Started) 

click on Existing Maps> Browse for more. 

The Open ArcMap Document dialog box appears. 

3. Navigate to the folder with the file - network data set of Kharkiv. 

4. Activate the ArcGIS Network Analyst plug-in by following these steps: 

a) click on Settings (Customize)> Additional modules (Extensions). The 

Extensions dialog box opens; 

b) mark ArcGIS Network Analyst; 

c) click Close. 
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If the Network Analyst toolbar doesn't appear, you'll need to add it by clicking 

Customize> Toolbars> Network Analyst. 

The Network Analyst toolbar will be added to ArcMap (Figure 2.1). 

 

Figure 2.1 

If the Network Analyst window does not appear, you need to add it. On the 

Network Analyst toolbar, click the Network Analyst window . 

The attached Network Analyst window will open (Fig. 2.2). 

  

  

Figure 2.2 

  

The Network Analyst window can be pinned and unpinned. 

  

Create a layer of the nearest service point 

Click Network Analyst on the Network Analyst toolbar and New Closest Facility 

(Figure 2.3). 

  

 

  

Figure 2.3 
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The Network Analyst window adds an analysis layer to the nearest service point. 

Network Analysis Classes - Facilities, Incidents, Routes, Point Barriers, Line Barriers 

and Polygon Barriers are empty (Fig. 2.4). 

  

Figure 2.4 

A new layer of analysis has also been added to the Table Of Contents window 

(Figure 2.5). 

  

  

Figure 2.5 
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Adding service points 

Next, you need to download service points from the layer of point spatial objects. 

Steps: 

1. In the Network Analyst window, right-click the button Facilities (0) and 

on Load Locations (Fig. 2.6). 

  

Figure 2.6 

It will open dialog window Downloads locations (Load Locations). 

2. Select Points from the Load From list by following these steps: 

a) click Browse for Features or Table to Load.  It will open Load Locations 

dialog box; 

b) click on Kharkiv.gdb \ Transportation \ Point; 

c) double-click on Point (Fig. 2.7). 

  

Figure 2.7 
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3. Click OK in the Load Locations dialog box (Figure 2.8). 

  

 

Figure 2.8 

  

Eight objects will be displayed on the map as service points and listed in the 

Network Analyst window (Fig. 2.9). 

  

 

Figure 2.9 
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Hint. Move the layers of objects from the table of contents and release them 

in the Network analysis class Facilities, which will allow you to quickly open the Load 

Locations dialog box. 

Add a user location 

The incident must be added by geocoding the address received with the 

emergency call. Steps: 

1. Click the Find button  panels. 

The Find dialog box opens. 

2. Go to the Spatial Objects tab (Fig. 2.10).  

 

Figure 2.10 

3. In the text box, find and enter Sumska, 24. Click on the Find  

button (Fig. 2.11). 

  

Figure 2.11 
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4. At this address, one location is defined and listed as a row in the table at 

the bottom of the Find dialog box. 

Right-click on this line and select Add as Network Analysis Object (Fig. 2.12). 

 

  

Figure 2.12 

The specified address will be added as an incident, which can be seen on the map 

display and in the Network Analyst window (Fig. 2.13). 

  

  

  

Figure 2.13 

  

5. Close the Find dialog box. 
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Adjust parameters for analysis 

Next, you need to set the parameters for the analysis of the nearest service point. 

Steps: 

1. Click the Analysis Layer Properties button in the Network Analyst 

window (Fig. 2.14). 

 

  

  

Figure 2.14 

  

The Layer Properties dialog box opens. 

2. Click the Analysis Settings tab. 

3. Make sure Impedance is defined as TravelTime (Minutes). 

4. Do not check Use Time. 

The Use Time option allows you to specify the start and end time of the analysis. 

When using a cost attribute with traffic information, day and date settings, you can 

determine the nearest service points by setting a dynamic travel time that varies 

depending on the traffic, but such an analysis will not use time. 

5. Enter 10 in the Default Cutoff Value text box. 

ArcGIS search for the nearest facilities located a ten-minute drive from the 

incident at 24 Sumska Street (str. Sumska, 24). Any objects located outside this time 

period are ignored. 

6. Enter 4 in the Facilities to Find field. 

ArcGIS search for a maximum of four nearby objects located near the scene of 

the incident. However, the three-minute restriction still applies; therefore, if the three 

nearest objects are within a three-minute drive, the fourth object will not be found. 

7. Select Facility to Incident for Travel From. 

Search results depend on the location of nearby objects loaded as service points. 
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8. Choose Allowed from the U-Turns at Junctions drop-down list. 

9. Click the Output Geometry Type drop-down arrow (Output Shape Type) 

and select True Shape with Measures. 

10. Uncheck Use Hierarchy. 

11. Check Ignore Invalid Locations. 

12. In the Restrictions box, clear the RestrictedTurns check box. 

Cars may not follow the rules of the road in case of emergency. 

13. Make sure the Directions box is set to 

Distance Units means Kilometers, the Use Time Attribute item is selected, and 

the Time attribute is set to Travel Time in Minutes (Fig. 2.15). 

  

 Figure 2.15 

14. Click OK. 

  

Identification of the nearest service point 

Steps: 

1. Click the Solve button toolbar Network Analyst. Routes appear on the 

map and in the ArcGIS Network Analyst window under the Routes class (Figure 2.16). 
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Figure 2.16 

Note that the analysis is configured to find four service points within the ten-

minute limit; however, only three service points are within this value. 

2. Click the Directions Window button  toolbar Network Analyst. It will 

open dialog window Directions. 

Directions of movement from each nearest object are given in the list in the 

corresponding window (fig. 2.17). 

 

Figure 2.17 
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 If you do not need to continue working with other exercises, close the ArcMap 

application. Click No to keep the changes. 

  

 2.2 Modeling of transport accessibility landfills 

and location of warehouses 

  

The basis for the development of long-distance passenger transport transport 

systems is the correspondence of passengers, the receipt of financial resources from 

which has the appropriate quality characteristics. The object is the state (regional) 

transport system of Ukraine. The aim is to model the landfills of maximum passenger 

route transport accessibility, taking into account certain restrictions [30-35]. 

To achieve the goal defined in the work it is planned to solve the following tasks: 

1. To consider the scientific approaches offered by contemporaries on 

modeling of passenger correspondence between nodes of a transport network. 

2. Model the ranges of maximum passenger route transport accessibility for 

different modes of transport. 

Scientists pay a lot of attention to the modeling of passenger route transport 

systems. As a result of this work, certain tasks were solved to consider not only state 

(regional), but also urban, interstate and intercontinental route passenger transport 

systems. 

Question intellectual planning urban passenger transport systems were 

considered by the authors of [17], who proposed an approach based on modeling the 

demand for dynamic intelligent planning and route optimization. The solution 

proposed by the authors in the work allows system operators to make decisions on the 

dynamic creation of new routes based on passenger requests. The model is proposed 

for implementation in projects Smart City. Modeling of routes within the city was also 

considered by the authors of the work [18]. They proposed a type of modeling that aims 

to predict the route network scheme taking into account the maximum interaction 

between bus and rail routes. The authors of [19] also addressed the issue of the need to 

take into account coordinated interaction between different modes of transport. They 
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offered form multimodal transport network, using a multicriteria routing 

algorithm for modeling. 

In [20] the question of the probability of passengers choosing the route of travel, 

provided there is a set of options. The model of the probabilistic process of bus service 

is determined. The authors of [21] solved the issue of passenger simulation of the total 

travel time in the route network depending on the number of transport nodes and the 

location of stopping points. The issue of improving the efficiency of passenger routes 

on rail transport is covered in [22]. The authors of [22] simulated the state of the system 

in the case of changes in the technical parameters of the route. 

The authors of [23] comprehensively investigated the effectiveness of the route 

passenger transport system. The developed mini-model is based on different modes of 

transportation and a multimodal public transport system. The paper proposes to apply 

flexible schedule optimization based on flexible modeling of car size. In [24] the results 

of researches of modeling of fluctuations of demand in case of transit operation of a 

bus route are presented. The approach to modeling the demand for travel and its 

distribution in accordance with the limitations of the volume at the zonal level, which 

are as mandatory as the capacity limitations of general references, considered in [25-

27]. The authors of [28] studied the impact of the volume of passenger correspondence 

as the main resource, affecting the development of transport infrastructure. Their 

influence is determined and the mentioned processes are modeled. 

The authors of [29] developed an algorithm for determining the area of 

distribution of road routes, taking into account the geographical location of railway 

passenger networks. Based on the proposed algorithm, a model of planning bus routes 

for railway stations has been developed. The authors of [30] considered the issue of the 

impact of population demand on the speed of movement. Changes in the functioning 

of passenger transport systems have been studied by other authors in [31–33]. 

In [34] it was determined that the main characteristic of the transport system is 

its accessibility. The paper considers the approach to modeling regional accessibility. 

The authors of [35] considered the issue of increasing population mobility. It is 

determined that the productivity of public transport is limited not only by its 
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accessibility, but also by its capacity. The actual capacity of the transport line is 

determined by the operating frequency, as well as the physical capabilities of each 

vehicle. The relationship between loaded demand and capacity helps to establish levels 

of comfort, including quality of service in general. Consideration of these phenomena 

in the destination model, which describes the user of the route and the mode of choice, 

as well as transportation of supplies should be limited to the capacity of vehicles (seats 

and standing places), movements during boarding and disembarking, 

[36] simulates the actual behavior of the passenger when choosing travel options 

that combine travel by public transport and car or bicycle. The definition of the network 

is based on the formation of the implemented set of route options with the choice of 

their optimal combination. The method and indicators of quality network quality 

assessment are offered. 

Among such approaches we can single out the one proposed in [37–42], used to 

predict the flow of passengers between different geographical locations. 

To create a series of landfills that can be reached from a service point over time, 

three-, five-, and ten-minute service areas have been calculated for six warehouses in 

Kharkiv. These landfills are a service area. 

You also need to determine how many stores are located in each of these service 

areas. It is necessary to choose a warehouse, the location of which is optimal for quality 

service of the store. Additionally, you need to create a Source-Destination matrix to 

deliver goods from the warehouse to all stores within 20 minutes. This matrix is used 

as an input for logistics, supply and route analysis. 

Steps: 

1. Attach the Road Network file to ArcMap. 

2. Activate the ArcGIS Network Analyst plug-in by running 

the following actions: 

a) click on Customize> Additional modules (Extensions). The Extensions 

dialog box opens; 

b) mark ArcGIS Network Analyst; 

c) click Close. 
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3. If the Network Analyst toolbar doesn't appear yet, you'll need to add it; 

Click Customize> Toolbars> Network Analyst. 

The Network Analyst toolbar will be added to ArcMap (Figure 2.18). 

  

 

Figure 2.18 

  

4. If the Network Analyst window doesn't appear yet, you'll need to add it. 

On the Network Analyst toolbar, click Network Analyst window . 

The attached Network Analyst window will open (Fig. 2.19). 

  

  

Figure 2.19 

The Network Analyst window can be pinned and unpinned. 

 

Creating a service area analysis layer 

Click Network Analyst on the Network Analyst toolbar and New Service Area 

(Figure 2.20). 

  

Figure 2.20 
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The service area analysis layer will be added to the Network window Analyst. 

Network analysis classes: Facilities, Polygons, Lines, Point Barriers, Line Barriers and 

Polygon Barriers - empty 2.21). 

  

Figure 2.21 

A new layer of analysis has also been added to the Table Of Contents window 

(Fig. 2.22). 

  

Figure 2.22 

 

Adding service points 

Next, it is necessary to add warehouses as service points for which service area 

landfills will be generated. 

Steps: 

1. Press CTRL while moving the Warehouses layer from the Table of 

Contents window and release it above the Facilities class in the Network Analyst 

window. 

The six warehouses will be loaded as service points and will appear on the map. 
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Figure 2.23 

2. In the Network Analyst window, click on the plus sign (+) next to Service 

Points (6) (Facilities (6)) to see a list of service points (Fig. 2.23). 

  

Setting parameters for analysis 

The next step is to calculate the service area based on travel time (in minutes). 

Calculate the trm service area polygons for each service point alternately for three, five, 

and ten minutes. It should be noted that the movement will take place from the service 

point, not to it, reversals are allowed and restrictions must be observed on one-way 

streets. 

Steps: 

1. Click the Analysis Layer Properties button in the Network Analyst 

window (Fig. 2.24). 

  

  

  

Figure 2.24 

The Layer Properties dialog box opens (Fig. 2.25). 

  



101 

 

 

Figure 2.25 

  

2. Click the Analysis Settings tab. 

3. Make sure the Impedance is set to Drive Time (in minutes). 

4. Enter 3, 5, 10 in the Default Breaks text box. 

5. IN section Direction click on From Away From Facility. 

6. Select Not Allowed from the list, U-Turns at Junctions. 

7. Check Ignore incorrect placements (Ignore Invalid Locations). 

8. Mark One-sided movement (One way) in menu Restrictions. 

  

The Analysis Settings tab should look like this (Figure 2.26). 

  



102 

 

 

Figure 2.26 

  

9. Click the Polygon Generator tab. 

10. Make sure Generate Polygons is selected. 

11. To set the Polygon Type, click Generalized. Detailed polygons are more 

accurate, but they take longer to generate. 

12. Uncheck the Trim Polygon option. 

The post-cultivation process cuts the outer boundaries of the landfill to remove 

emissions, and additional time is required. 

13. Click Overlapping to go to the window Parameters for multiple service 

points (Multiple Facilities Options). 

Separate landfills are created for each service point. The landfill of one service 

point may overlap with the landfill of another, the nearest service point. 

14. Click Rings for Overlap. This excludes areas with lower limits from 

landfills with large boundaries. 

15. Click Apply to save the settings. 

16. Click the Line Generation tab. Do not check Generate Lines. 
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Although the lines from the edges that intersect in this exercise will not be 

generated, you can do so using this option. 

It can be applied to baselines, landfills or both. 

17. Click OK. 

  

Service area calculation 

  

Steps: 

1. Click the Solve button toolbar Network Analyst. Service area landfills 

will appear on the map and in the Network Analyst window. Landfills are transparent, 

which allows you to see the streets below them. However, instead of setting the 

transition from dark to light in the case of increasing the distance, you need to change 

the settings for the transition of color from light to dark. 

2. In the Table Of Contents, right-click the Polygons sublayer and select 

Properties. 

3. Select the Symbology tab. 

4. Click on the name of the Symbol field and select Flip Symbols (you need 

to make sure that Symbol is clicked with the left, not the right mouse button, otherwise 

you will not see the context menu) (Fig. 2.27). 

  

 

Figure 2.27 

  

5. Click OK. 
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The outer and inner service areas are distributed by the color of the switch, 

providing a clearer view of the areas beyond ten-minute values (Fig. 2.28). 

  

 

Figure 2.28 

  

Identification of stores located outside the service areas 

  

Steps: 

1. In the Table Of Contents window, click and move the Stores at the top of 

the Layers list to improve visibility (Fig. 2.29). 

  

Figure 2.29 
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2. Click on Select (Select By Location) (Fig. 2.30). 

  

  

Figure 2.30 

  

3. Create a sample query in the Select By Location dialog box to select items 

from stores inside the landfills, as shown in Figure 2.31. 

  

Figure 2.31 
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4. Click OK. 

The shops located within the landfills, behind the landfills of the service area, 

are selected. 

5. In the Table Of Contents window, right-click Stores and on Selection> 

Switch Selection. 

The sample will show the distribution of stores that were not located in the 

service area. This sample is used to determine to which area the warehouse will be 

transferred. The best are the areas located in the center of the map (Fig. 2.32). 

  

 

  

Figure 2.32 

6. On the Tools toolbar, click the Clear Selected Features button. 

  

Moving the least available warehouse 

It is clear from Figure 2.32 that there are no stores within the three-, five- or ten-

minute availability areas of the service area around warehouse № 3 (Graphic Pick 27), 

so this warehouse needs to be relocated for better store service. 
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Steps: 

1. In the Network Analyst window, select Warehouse № 3 (Graphic Pick 27) 

under Facilities (6) (Fig. 2.33). 

  

  

Figure 2.33 

  

2. Click on tools Select / Move Select / Move Network Location   Network 

toolbar Analyst. 

3. Move the warehouse № 3 to the center of the map as shown in Figure 2.34. 

4.  

  

Figure 2.34 
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5. Start the service area calculation process. To do this, click the Solve button

Network Analyst toolbar. 

Service area landfills will appear on the map and in the Network Analyst 

window. 

 

Identification of the landfill service area in which all stores are located 

  

Steps: 

1. In the Table Of Contents window, right-click Stores and Joins and 

Relates> Join (Figure 2.35). 

  

 

Figure 2.35 

  

The Join Data dialog box opens. 

2. Choose Data from another layer based on position spaces (Join data from 

another layer based on spatial location) (Fig. 2.36). 

  

  

Figure 2.36 
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3. Select Polygons as the layer to connect to the previous layer (Figure 2.37). 

  

Figure 2.37 

4. Click on the button "inside" which it got (Fig. 2.38). 

  

  

Figure 2.38 

  

In this way, the attributes of the polygon are added to all points that fall inside 

the polygon. 

5. Specify Location weekend shapefile or class of spatial 

objects to save the results of the connection and name them Stores With  

Poly (Fig. 2.39). 

  

Figure 2.39 

  

6. Click OK. 
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ArcGIS connects and adds a new layer to the map document. 

7. In the Table Of Contents, right-click a new layer of Stores With Poly 

objects and select Open Attribute Table. 

Each row in the table contains the name of the store and landfill to which it 

belongs. You can use this table to generate other useful categories, such as the number 

of stores within 0 to a three-minute availability area. 

8. Close the attribute table. 

9. Additionally, you can export service points (including relocated ones) as 

classes of spatial objects. 

In the Network Analyst window, right-click Facilities (6) and select Export Data. 

The Export Data dialog box opens. 

10. From the Export list, select All features. 

11. Choose the original location and type (shapefile or class) of spatial objects. 

You can select a geodatabase to save the feature class 

Paris: C: \ arcgis \ ArcTutor \ Network Analyst \ Tutorial \ Kharkiv.gdb \ 

Export_Output (Fig. 2.40). 

  

  

Figure 2.40 

  

12. Click OK. 
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Will appear message from question or you want you add 

exported data to the map. 

13. Click No. 

No data is required for the rest of this exercise. 

  

Creating a layer of analysis of the source-destination matrix 

  

Additionally, it is necessary to create a Source-Purpose matrix for the delivery 

of goods from the new warehouse to all stores. The results of this matrix can be used 

to identify the stores that will be serviced by each warehouse located within twenty 

minutes of travel time. In addition, you can determine the travel time from each 

warehouse to the appropriate store. 

Steps: 

1. In the Table Of Contents, uncheck the Service Area analysis layer and the 

Stores With Poly object layer to improve map readability. 

2. Click Network Analyst on the Network Analyst toolbar and the New OD 

Cost Matrix (Fig. 2.41). 

  

  

 

  

Figure 2.41 
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The Source-Destination matrix analysis layer has been added to the Network 

window Analyst. Network analysis classes: Origins, Endpoints (Destinations), Lines, 

Point Barriers, Line Barriers and Polygon Barriers are empty (Fig. 2.42). 

  

  

Figure 2.42 

A new layer has also been added to the Table Of Contents window  

analysis (Fig. 2.43). 

  

Figure 2.43 
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Adding origins 

  

Service area service points can be used as sources (previous sections). If you use 

all partitions in service areas, you can use a layer of spatial objects instead. 

Steps: 

1. In the Network Analyst window, right-click on Sources (Origins (0)) and 

select Load Locations. The Load Locations dialog box opens. 

2. Click on ServiceArea / Facilities in the list, Load From (if the previous 

section in the service area is not completed, select Warehouses instead). 

3. Uncheck Only load selected rows. 

4. In the Location Position section, click Use Network Location Fields (If 

loading warehouses are loaded, click Use Geometry). 

Using network location fields allows ArcGIS to use an already located service 

area position to redefine them as a source. This method provides a quick re-

determination of the location of the object compared to the spatial search (Fig. 2.44). 

 

Figure 2.44 
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5. Click OK. 

Six new objects are displayed in the Network Analyst window in the Origins 

section (Figure 2.45). 

  

  

  

Figure 2.45 

Add appointments 

  

Steps: 

1. In the Network Analyst window, right-click the Destination button 

(Destinations (0)) and choose team Load Locations. 

2. Select Stores from the Load From list. 

3. In the Location Analysis Properties section, select Name for the property 

name in the Field list. 

Until the English name of the field Name is configured in the file 

NASolverConfiguration.xml, ArcGIS will not be able to automatically match the name 

of the field with the map (Fig. 2.46). 
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Figure 2.46 

4. Click OK. 

  

The Network Analyst window contains a list of 25 destinations (Fig. 2.47). 

 

 Figure 2.47  
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These values are displayed on the map (Fig. 2.48). 

  

 

Figure 2.48 

  

Setting parameters for analysis 

  

At the next stage it is necessary to calculate the matrix SourceAppointment by 

travel time. You must set the default reduction value to 20 minutes and adjust the 

settings so that all destinations are within the restricted area. Additionally, it should be 

noted that reversals are always allowed, and the original geometry must be straight. As 

the route is performed on the road, one-way traffic restrictions should be taken into 

account. All invalid placements (location not found) are ignored. 

Steps: 

1. Click the Analysis Layer Properties button in the Network Analyst 

window (Fig. 2.49). 
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Figure 2.49  

2. Click the Analysis Settings tab. 

3. Make sure the Impedance drop-down list is set to Drive Time (in minutes). 

4. Do not check Use Start Time. 

5. Enter 20 in the Default Cutoff Value text box. 

In this way, Source-Destination directions will be created from each warehouse 

to all stores located within 20 minutes of the route. Minutes are used as units because 

the impedance attribute is specified in minutes. 

6. Make sure the <All> property of the Destinations To Find properties is 

set. 

7. Select Allowed from the U-Turns at Junctions drop-down list. 

8. Make sure the Output Shape Type section is set to Straight Line. 

9. Make sure Ignore Invalid Locations is selected. 

10. Check One way in the Restrictions menu (Restrictions) (Fig. 2.50). 

  

Figure 2.50 
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11. Click OK. Settings saved. 

  

Start the process of creating a source-destination matrix 

  

Click the Solve button Network Analyst toolbar. Source-Destination lines will 

be displayed on the map. In this example - 74 lines (Fig. 2.51). 

 

Figure 2.51 

  

This number will depend on where the warehouse is moved № 3 (Fig. 2.52). 

  

Figure 2.52 
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If layer area service not will be displayed turn on the matrix 

layer display Source-Purpose in the upper part of the service area of warehouses. 

  

Allocation of shops for warehouses 

The Source-Destination matrix can be used to identify the stores that will be 

serviced by each warehouse. 

Steps: 

1. In the Network Analyst window, right-click Lines (74) and select Open 

Attribute Table (Fig. 2.53). 

  

  

  

Figure 2.53 

  

The Lines table opens. 

The Lines table is a Source-Destination matrix from each warehouse to all stores 

within 20 minutes. The OriginID column contains the identifiers of the warehouses. 

The Destination ID column contains store IDs. Destination Rank is the rank assigned 

to each destination served by the store based on the total travel time. For example, in 

the table (Fig. 2.54) it is indicated that for warehouse № 1 destination identifier 2 

(Destination ID 2) has rank 1, and destination ID 3 has rank 2. This is due to the fact 



120 

 

that the path from warehouse № 1 to Destination ID 2 takes less time (this case may 

differ because the results of the analysis depend on the source class of spatial objects 

of sources and purposes). 

  

 

  

Figure 2.54 

  

The Source-Destination matrix displays the stores serviced by each warehouse, 

along with the total travel time for each route. Some stores are within a 20-minute reach 

of more than one warehouse and can be serviced by any of them. The Source-

Destination Matrix can also be used as an introduction to logistics routing models that 

use source destination matrices to separate goods and services. 

2. If you do not need to continue working with other exercises, close. 

ArcMap application. Click No to save the changes. 

3. If you need to work with other exercises, you need to do the following 

actions. 

a) open File> New. A dialog box will appear New Document; 

b) click OK; 

c) Click No in response to the request to save changes. 



121 

 

Similarly, the models of maximum passenger route transport accessibility for 

different types of transport were modeled using the geographical model of the transport 

network of Ukraine. In the selected model of the network, regional centers are defined 

as transport nodes, links - highways of state and regional importance and  

railways (Fig. 2.55, 2.56). 

 

Figure 2.55 

 

Figure 2.56 
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The figures show that the road and rail transport networks are different. The 

number of links in the car network is greater, it provides the opportunity to build 

landfills that differ from each other. The selected models of transport networks meet 

the requirements for the reliability of data with tolerable geographical deviation. This 

allows you to use the selected model for further research. ArcGIS software (Network 

Analyst application) was used to model the polygons of maximum passenger route 

transport accessibility for different types of transport. 

Transport accessibility landfills have been built for transport nodes, taking into 

account certain conditions of the transportation process - average time and average 

driving speed. When modeling the landfills of the maximum passenger route 

accessibility of the transport system, the average driving time for road transport was 

chosen to be equal to 1.5; 3; 5 and 8 h, and the average speed of connection is 46 km / 

h and 73 km / h, which corresponds to the speeds of interregional bus service used in 

the research system. Models of landfills for maximum passenger route transport 

accessibility for road transport at transport hubs, which correspond to such regional 

centers as Luhansk, Odesa, Dnipro, Kyiv, Simferopol, have been built. Figures 2.56–

2.58 show the results of modeling on the example of a landfill, built relative to the 

transport hub corresponding to the city of Dnipro: model of landfills of maximum 

passenger route transport accessibility by road at a speed of 46 km / h and a driving 

time of 1.5; 3; 5 and 8 hours, respectively (Fig. 2.57); model of landfills of maximum 

passenger route transport accessibility on motor transport at a speed of 73 km / h and a 

driving time of 1.5; 3; 5 and 8 hours, respectively (Fig. 2.58). 
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Figure 2.57 

  

Figure 2.58 

  

Similar models, taking into account the limitations of transport accessibility 1.5; 

3; We are building 5 and 8 o'clock for railway transport. The following speed limits 

were used during the simulation, namely: 31 km / h, 68 km / h and 98 km / h, which 

corresponds to the speeds of interregional railway connections used in the research 

system. The simulation results are shown in Figures 2.59–2.61 on the example of a 

landfill built relative to the city of Dnipro: model of landfills for maximum passenger 

route transport accessibility on railway transport for certain parameters (31 km / h, 1.5, 

3, 5, 8 h) (Fig. 2.59); model of landfills of maximum passenger route transport 
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accessibility on railway transport for certain parameters (68 km / h, 1,5, 3, 5, 8 h) (Fig. 

2.60); 

  

  

 

Figure 2.59 

It is established that during the modeling of the route network for passenger 

transportation in relation to the selected transport node the realization of passenger 

route transport correspondence is provided. Certain correspondences can be realized 

between the center of the constructed landfill and three other nodes only if you drive 

for up to 8 hours. 

  

Figure 2.60 
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Figure 2.61 

It is established that during the modeling of the route network for passenger 

transportation relative to the selected transport node, the implementation of passenger 

route transport correspondence is provided [42–45]. If passengers keep the set 

parameters of modeling landfills for maximum route transport accessibility, it is 

established that within 1.5 hours of driving the landfill contains only one node, except 

for the landfill construction center. When considering the landfill, which corresponds 

to transport accessibility when driving within 1.5 to 3 hours, you can reach four 

transport hubs. In the case of the organization of scheduled transportation with the 

definition of the average speed of 98 km / h and driving time from 3 to 5 hours from 

the center of the constructed landfill can reach up to seven nodes; up to six knots can 

be reached in 5 to 8 hours. Comparing Figures 2.58 and 2. 

The model of landfills was implemented using the model of the road network, 

which, unlike the previous ones, is a combination of road and railway networks. Figure 

2.62 shows the same model of landfills for maximum passenger route transport 

accessibility in the integrated road network [46]. 
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Figure 2.62 

 

The results of modeling the parameters of route accessibility of transportation 

were studied in both road networks simultaneously. It was found that within a 1.5-hour 

drive, the railway test site at a speed of 68 km / h does not reach any nodes (cities) in 

both networks, and the road test site with the same speed contains one node (city). The 

landfill built on railways when driving within 1.5 to 3 hours contains one transport 

node, and the road in these conditions - two. During the examination of the landfill, 

which corresponds to the transport accessibility by rail within a ride of 5 to 8 hours, it 

was found that it contains eleven transport nodes, and the road in these conditions - 

thirteen. Comparing rail and road transport accessibility, we can conclude that 

The strengths of the study can be considered that the obtained landfills were 

modeled with geographical accuracy, the results of simultaneous operation of railway 

and road networks. In contrast to the previously proposed approaches to solving the 

problems of planning the indicators of the transport process by means of network 

analysis, a comprehensive approach with the use of the latest information technologies 

is proposed. 

The disadvantage of the study can be considered the lack of consideration of 

changes in the total travel time in the event of changes in the networks through which 

transportation is carried out. However, the proposed approach determines that it is 
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possible to provide such conditions under which the transport accessibility of the 

networks when using both networks in one ride will be maximum. Failure to take into 

account the increase in driving time when changing networks may lead to a decrease 

in the average driving speed, which will be the basis for reducing the identified landfill. 

The proposed study can be obtained in particular regarding the planning of time 

and energy resources used in the transportation process. 

The disadvantages of the proposed method of planning parameters are the 

disregard for the characteristics of each arc of the studied network. Probably, the reason 

was that the speed not used on some sections of railways and highways was used to 

determine the landfills to calculate the speed of movement. This led to the receipt of 

settlement landfills with unrealistic characteristics. 

  

2.3 Determination of the density of the transport network 

  

Provided that passengers have the opportunity to meet the needs for movement 

in the most convenient way, it is possible to realize the maximum potential transport 

correspondence between the nodes of the transport network. The basic factors that 

affect the actual volume of passenger traffic between the nodes of the transport network 

can be considered: 

• potential correspondence; 

• fare; 

• driving time; 

• time of day of the ride; 

• riding comfort; 

• regularity and frequency of driving; 

• social and economic characteristics of regional development in transport hubs. 

It should be noted that the actual indicators of passenger traffic should be 

adjusted to take into account the characteristic seasonal or daily fluctuations. 
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According to the results of the analysis, it is established that today the issue of 

determining the impact of road network parameters on the economic and social 

condition of the regions is insufficiently studied. The issue of determining the quality 

of the road network design and the compliance of the available drawings with the 

optimal ones has not been fully studied. 

To determine the efficiency of road networks, the impact of road network 

development on social and economic indicators, it is proposed to use methods of 

systems analysis. The actual state of development of road networks with the congestion 

of geographic information systems was studied on the example of the road network of 

Ukraine. 

The author of [38, 47] considers the density of the road network as a basic 

indicator. It is proposed to determine the total public costs of transportation by 

dependence (2.1). 

  

 

where Спг - cost of an hour of transport time, UAH / hour; 

Z - total public transportation costs, UAH; 

Н - number of rides per year, units; 

Сб- cost of construction and operation of one kilometer of road network, UAH; 

δ - density of the transport network, 1 / km; 

Fc - residential area of the city, km2; 

Тзв- consolidated travel time of medium distance, h. 

Thus, it is clear that the state of the road network affects the density and the 

combined travel time of medium distances. 

The combined time of a medium-distance trip undoubtedly depends on the length 

of the medium-distance trip, which, in turn, is determined by the peculiarities of the 

road network pattern. 

Under such conditions, it is fair to say that the optimal cumulative travel time 

for medium-distance travel is the minimum time. It is possible to minimize the reduced 

(2.1) 
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travel time of a medium distance by increasing the driving speed or reducing its 

distance [48-52]. 

Driving speed is a quantitative reflection of the complex interaction of a set of 

factors, namely: the technical capabilities of the vehicle, road characteristics, the 

number and features of stops and more. You can reduce the riding distance by 

determining the shortest riding route. Graph theory is mostly used when planning 

variants of route schemes using modern mathematical approaches [53-56]. 

We calculate the transport development of the territory with paved roads on the 

example of Kharkiv. 

  

Preparing the display Steps: 

1. Open the network dataset set file. 

2. In the ArcMap - Getting Started dialog box, click Existing Maps> Browse 

for more. 

3. Navigate to the C: \ ArcGIS \ ArcTutor \ ArcGIS Network Analyst \ 

Tutorial \ KharkivTransportation folder. 

4. This default location is for setting up learning materials. Double-click the 

Kharkiv.mxd file. The map document will open in ArcMap (Fig. 2.63). 

 

Figure 2.63 
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5. Activate the ArcGIS Network Analyst plug-in by running the following 

actions: 

a) click on Settings (Customize)> Additional modules (Extensions). The 

Extensions dialog box opens; 

b) mark ArcGIS Network Analyst; 

c) click Close. 

If the Network Analyst toolbar doesn't appear, you'll need to add it. 

6. Click Customize> Toolbars> Network Analyst. 

The Network Analyst toolbar will be added to ArcMap (Figure 2.64). 

  

 

  

Figure 2.64 

  

If the Network Analyst window does not appear, you need to add it. 

On the Network Analyst toolbar, click the Network Analyst window. The 

attached Network Analyst window will open (Fig. 2.65). 

  

  

Figure 2.65 

The Network Analyst window can be pinned and unpinned. 
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Construction of hexagons throughout Kharkiv 

To build hexagons, use the Generate Pattern of Repeating Shapes tool. Steps: 

1. Click the Generate Pattern of Repeating Shapes button contained on the 

main toolbar. 

The Generate Pattern of Repeating Shapes tool dialog box opens (Figure 2.66). 

  

  

Figure 2.66 

2. Click Next. 

3. Select the Kharkiv polygon where the hexagons will be created. 

4. Select Use all records. 

5. Click OK. 

6. Choose the value of the hexagons Hexagons. 

7. Click Next. 

Hexagon Parameters opens. 

8. In the Area area, enter a value of 10,000,000. 

The value of 10,000,000 m2 (10 km2) is the area of each hexagon. 

9. In the Output Feature Class or Shapefile value, select the path to save the 

shape file named Hexagons (Fig. 2.67). 
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Figure 2.67 

10. Click OK. 

11. A dialog box opens, click the Exit button. 

A layer of hexagons has been added to the map and Table of Contents window 

(Figs. 2.68, 2.69). 

  

  

Figure 2.68 
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Figure 2.69 

  

Editing hexagons 

Use the Clip tool to cut hexagons along the Kharkiv border. 

  

Steps: 

1. Click the Geoprocessing button on the main toolbar. 

2. Select the Clip tool. 

The Clip dialog box opens. 

3. In the Input Features field, select Hexagons. 

4. In the Clip Features field, select Kharkiv. 

5. In the Output Future Class field, set the save mode and name the shape 

file Clip (Fig. 2.70). 
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Figure 2.70  

6. Click OK. 

7. Remove layers of Hexagons and Kharkiv landfill from Table of Contents. 

With the help of the Clip tool, hexagons along the Kharkiv border were edited, 

and a new shape file called Clip was added for further work (Figs. 2.71, 2.72). 

  

Figure 2.71 

 

 

Figure 2.72 
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8. Right-click the Clip file and open the attribute table. 

9. Click the Table Options button and select the Add Field function. 

10. In the Name field, enter the name Area. 

11. In the Type field, select Double. 

12. Click OK. 

  

Add a column in the table of attributes called Area (Fig. 2.73). 

 

Figure 2.73 

13. Left-click on the Area column to select the entire column. 

14. Right-click on the Area column and select Field Calculator. 

15. Click Yes. 

The Field Calculator dialog box opens. 

16. In the Fields window, double-click Shape_Area to add this column to the 

Area = window (Figure 2.74). 
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Figure 2.74 

  

17. Click OK. 

  

  

Using the Field Calculator function, the area of each hexagon in the Double type 

was calculated (Fig. 2.75). 
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Figure 2.75 

  

  

Intersection of highways with a layer of hexagons To get started, you'll need to 

add a layer of roads to the map. 

Steps: 

1. Click the Add Data button (Fig. 2.76). 

  

 

  

Figure 2.76 

  

2. Select the folder KharkivTransportation / Kharkiv.gdb, which contains the 

shape file of streets (streets Kharkiv) and double-click on it. 
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A shape file of the street has been added to the map of Kharkiv (Fig. 2.77). 

 

  

Figure 2.77 

  

Use the Intersect tool to assign each hexagon number where it is located. 

3. Click the Geoprocessing button on the main toolbar. 

4. Select the Intersect tool. 

The Intersect dialog box opens. 

5. In the Input Features field, select StreetsKharkiv and Clip. 

6. In the Output Features Class field, set the way to save a new shapefile file 

called inter_Kharkiv_hard to the Kharkiv.gdb file database (Fig. 2.78). 
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Figure 2.78 

  

7. Click OK. 

Added a new shapefile named inter_Kharkiv_hard. 

8. Open the attribute table of the inter_Kharkiv_hard shapefile 

(Fig. 2.79). 

  

  

Figure 2.79 
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This table contains information about the name of the road (Name), the type of 

road (Type), the hexagon in which it is located (Unique_ID), the area of the hexagon 

(Area), and so on. 

 

Determination of the number, sum of road lengths and density coefficients in 

each hexagon 

 

Use the Summary Statistics tool to calculate the sum of the length, the number 

of roads, and the density factor in each hexagon. 

Steps: 

1. Click the ArcToollbox button. A set of tools opens (Fig. 2.80). 

  

  

  

Figure 2.80 

  

2. Double-click Analysis Tools. 

3. Double-click Statistics. 

4. Select the Summary Statistics tool. 

The Summary Statistics tool dialog box opens. 
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5. In the Input Table field, select the inter_Kharkiv_hard shapefile. 

6. In the Output Table field, specify how to save the file to the Kharkiv.gdb 

database called inter_Kharkiv_hard_Statistics. 

7. In the Statistics Field (s) field, select Shape_leng. 

8. In the Statistic Type column, select SUM. 

9. In the Case Field (optional) column, select the Unique_ID and Area values 

(Figure 2.81). 

 

Figure 2.81 

10. Click OK. 

11. Close the ArcToolbox. 

Added a table called inter_Kharkiv_hard_Statistics, in which the column 

FREQUENCY is the number of roads in each hexagon, SUM_Shape_Leng is the sum 

of the lengths of the roads in each hexagon, Area is the area of each hexagon. 

12. Click the Table Options button and select the Add Field function. 

13. In the Name field, enter the name Plot_tr_set. 

14. In the Type field, select Double. 

15. Click OK. 

16. Left-click on Plot_tr_set to select the entire column. 
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17. First click on the Plot_tr_set column and select Field Calculator. 

18. Click Yes. 

The Field Calculator dialog box opens. 

19. In the Fields window, double-click SUM_Shape_Leng to add this column 

to the Plot_tr_set = window. 

20. In the Plot_tr_set window, add a delimiter. 

21. In the Fields window, double-click Area to add this column to the 

Plot_tr_set = window (Figure 2.82). 

  

Figure 2.82 

22. Click OK. 

Added column Plot_tr_set, which contains the coefficient of road density in each 

hexagon (Fig. 2.83). 
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Figure 2.83 

  

2.4  Conclusions by section 

  

The strengths of this study include the ability to apply a certain coefficient of 

straightness of the road network when assessing the location of production sites, which 

will minimize the transport component in the final cost of production, and thus lead to 

positive socio-economic consequences. New information on the characteristics of the 

road network of Ukraine was obtained [57]. 

The shortcomings of the study and the results obtained can be considered the 

inability to take into account the fact of the existing railway network in Ukraine. 

However, it should be noted that the purpose of this work was to determine the impact 

of the road network pattern on the basic indicators of the transport process. Taking into 

account the fact that highways are more common than railways, we can assume that 

the goals of the work have been achieved [42, 58-59]. The study also considered the 

options for the shortest connection of transport hubs, which can be further 
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implemented, taking into account the possibility of travel on all roads. This way you 

can set the shortest routes, which are always the fastest. It should be noted 

Accurately calculated value of the coefficient of straightness of the road network 

makes it possible to plan the development of transport infrastructure and meet the needs 

of the population for transportation within the research system. At the same time, it is 

possible to improve the quality of financial flows of production by optimizing the 

allocation of resources [60-63]. 

There are also difficulties associated with the application of the results of the 

study. This applies to the processes of optimizing the selected model of the road 

network by introducing additional arcs in it. It is proposed to implement the need to 

move between the nodes of the network on the shortest connection, which can lead to 

the use of network arcs with relatively low connection speeds and increase the total 

driving time. 
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3 ROUTE MODELING 

  

3.1 Construction and analysis of the route model 

  

This section describes the process of creating a model to determine the shortest 

route connecting the 25 transport hubs of Kharkiv. 

Steps: 

1. Activate the ArcGIS Network Analyst plug-in by following these steps: 

a) click on Settings (Customize)> Additional modules (Extensions). The 

Extensions dialog box opens; 

b) mark ArcGIS Network Analyst; 

c) click Close. 

If the Network Analyst toolbar doesn't appear, you'll need to add it. 

2. Click Customize> Toolbars> Network Analyst. 

The Network Analyst toolbar will be added to ArcMap (Figure 3.1). 

  

 

Figure 3.1  

If the Network Analyst window does not appear, you need to add it. 

3. On the Network Analyst toolbar, click the Network Analyst window. The 

attached Network Analyst window will open (Fig. 3.2). 

  

  

Figure 3.2 
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 The Network Analyst window can be pinned and unpinned. 

  

Creating a model Steps: 

1. Click the Catalog window button Standard toolbars. 

The Catalog window opens. 

In the Catalog window, expand the Toolboxes node. 

2. Click right button mouse on items My Toolboxes and select the 

command New (New)> Toolbox (Toolbox) (Fig. 3.3). 

  

 

Figure 3.3 

  

3. Enter the Network Model and click ENTER to name the added toolkit. 

4. Right-click the Network Model toolkit and choose New> Model. 

The new model will appear in the toolkit and open the Model dialog  

box (Fig. 3.4, 3.5). 

  

  

Figure 3.4 
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Figure 3.5 

Creating a route layer in the model 

Next, a route layer will be created in the model. The process of using the ArcGIS 

Network Analyst plug-in in the model coincides with the process of using the Network 

Analyst in ArcMap. First you need to create a route layer and set the properties. Next 

you need to add network locations (stops), which will be the input data and display the 

results. 

Steps: 

1. IN menu click on Geoprocessing (Geoprocessing)> Search For 

Tools. The attached Search window will open, in which the Tools category is 

highlighted (Fig. 3.6). 

  

Figure 3.6 
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2. Click Network Analyst Tools from the list of toolkits in the Search 

window. 

A list of tool groups and tools related to the ArcGIS Network Analyst plug-in 

appears. 

3. Click Analysis in the Search section of the Search window. 

The Search window displays only tools related to network analysis. 

4. Drag the Make Route link Layer in the Model dialog box (Fig. 3.7). 

  

 

Figure 3.7 

  

5. In the Model dialog box, double-click Make Route Layer. 

The Make Route Layer dialog box opens, where you can set properties. 

6. From the Input analysis network list, select Streets_ND. 

7. In the Impedance attribute list, click Drive Time. 

8. Check the box next to Reorder stops to find optimal route. 

1. From the Preserve ordering of stops list, click PRESERVE_BOTH. 

The tool dialog box should look like this (Fig. 3.8). 
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Figure 3.8 

  

2. Click OK. 

The input analysis layer is added to the model. The Make Route Layer turns 

yellow and the result turns green. 

3. Click the Full View> Full View button. The entire model will be 

displayed. 

  

Add stops to the route layer 

Next, stores will be added as stops using the Add Locations tool. 

  

Steps: 

1. Drag the Add Locations tool from the Search window to the Model dialog 

box (Figure 3.9). 
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Figure 3.9 

  

2. Select the Transports functional layer in the Table Of Contents window 

and drag it to the model to the left of the Add Locations tool (Figure 3.10). 

  

  

  

Figure 3.10 

3. In the Model dialog box, select the Connect Connection tool. 
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4. Click on Transports and Add Locations to connect to them. In the context 

menu, click on Input locations (Fig. 3.11). 

  

 

  

Figure 3.11 

  

5. Using the Connect tool, select Route to the Add Locations tool. In the 

context menu, click on the Input network analysis layer (Fig. 3.12). 

  

 

  

Figure 3.12 
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6. Click the Auto Layout button .The model is organized in a logical order. 

7. 

  

  

  

Figure 3.13 

  

Adding a Calculation Tool (Solve) Steps: 

1. Drag the Solve tool from the Search window to the Model dialog box 

(Figure 3.14). 

  

 

Figure 3.14 

Click  on   button      ( Full   View)     ( Fig. 3.13).     
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2. Using the Connect tool, lift the Route output layer (2) to the Calculation 

tool (Solve). In the context menu, click on the Input network analysis layer. 

The Solve tool will turn yellow, the source layer will turn green, and the Solve 

succeeded will turn blue. 

3. Click the Auto Layout button . 

 

Figure 3.15 

  

5. Click on the Select tool .  

6. Right-click on the source layer of the tool 

Add a provision, which is known as Route (2), and select the Add To Display 

command (Fig. 3.16). 

4.   Click   on   button   Full   Appear 

ance 

  ( Full   View)     ( Fig. 3.15) .   
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Figure 3.16 

According to the Calculation (Solve), which is marked as Route (3), select the 

command Add To Display (Fig. 3.17). 

  

 

Figure 3.17 
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 WARNING 

The Add To Display command will not ensure that the result is added to the map 

when you run the tool from the toolkit. If you want to add the result to the map, right-

click on the result (Layer Route (3)) and select Model Parameter (Fig. 3.18). 

  

 

Figure 3.18 

This will force the model to add the final result to the map display at startup from 

the Model dialog box. 

     

Launch the model to find the best route  

Steps: 

1. Click the Save button,  to save the model. 

2. Click the Run button . 

A status window appears showing ArcGIS route analysis. 

3. Close the status window and the Model dialog box to view the results. 

A tooltip appears indicating the need to save the model. 

4. Click Yes. 

The Network Analyst window displays all stops and the resulting route, so the 

map shows the downloaded stops and the resulting route (Fig. 3.19). 
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Figure 3.19 

  

A new route layer has been added to the Table Of Contents window. 

Adjust the model to save the results to disk 

Steps: 

1. In the Catalog window, expand the Network Model toolkit, right-click the 

Model node, and then click Edit. 

For receiving access to functional class To determine the 

shortest route, you must first copy the characteristics from memory to disk. 

2. Right-click on the model and select tools only for the model, and then - 

Select Data (Select Data) (Fig. 3.20). 
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Figure 3.20 

  

3. Using the Connect tool, drag the resulting output layer (Route 3) to the 

Select Data tool. Click on the Input Data Element in the context menu (Fig. 3.21). 

  

 

Figure 3.21 

4. In the Model window, double-click the Select Data button. The Select 

Data dialog box opens (Figure 3.22). 
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Figure 3.22 

5. Select Routes in the Child Data Item list (Child Data Element) (Fig. 3.23). 

  

 

  

Figure 3.23 
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6. Click OK. The dialog box closes. 

7. Type Copy Features in the text box of the Search window, and then press 

ENTER. 

8. Drag tool Copying characteristics (Copy Features) from the search results 

in the Model dialog box (Fig. 3.24). 

  

  

Figure 3.24 

  

9. Using the Connect tool,  drag the resulting source layer (Routes) to the 

Copy Features tool. Click on Input Features in the context menu (Fig. 3.25). 

  

Figure 3.25 
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10. In the Model dialog box, double-click Copy Features. 

It will open dialogwindow Copying characteristics (Copy Features) (Fig. 3.26). 

  

 

  

Figure 3.26 

  

11. Enter the original location to save the route as a feature class or shapefile. 

For example, you can enter the location C: \ arcgis \ ArcTutor \ Network Analyst 

\ Tutorial \ Exercise06 \ Kharkiv.gdb \ path. 

12. Click OK. 

Therefore, during the launch of the model, the most optimal route will be found 

and the sublayer of the route exported to the performance class will be selected. You 

can start the model by clicking the Run button . 

  

Remove model 

Steps: 



161 

 

1. In the Catalog window, go to the Network Model toolkit, right-click on 

the Model node, and select Delete (Figure 3.27). 

  

  

Figure 3.27 

  

A tooltip appears indicating the need to confirm the deletion. 

If the model was running, you also need to go to the folder specified to save the 

original data of the tool "Copy characteristics" and delete the created characteristic 

class. 

2. Click Yes. 

3. Exit ArcMap and do not save the changes to the Exercise6.mxd file. 

  

3.2 Modeling of routes for freight transportation with definition 

basic parameters of their functioning 

  

Municipal public freight transport is a vital subsystem of the municipal 

economy, the activity of which determines the functioning of all spheres of activity of 

cities, enterprises and organizations [64–73]. 
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Management involves the impact on the object, selected from many possible 

influences, on the basis of available information that supports the stability or 

development of the object. 

The managed object and the associated governing body form a management 

system. The control signals provided by the executive body on the basis of the 

processed information change the control actions in accordance with the control 

signals. 

In the most general form of management can be defined as streamlining the 

system, ie bringing it in line with a certain objective pattern that operates in this 

environment. This wording contains one essential feature of management processes - 

their universality in the sense that they can be applied to any object, because there are 

no areas that could not be ordered. In form, this process is a combination of control and 

managed systems [39, 75]. 

Arranging and combining elements of the managed system provides a solution 

to the four main tasks of management - stabilization, program execution, monitoring 

and optimization. 

Transport systems provide solutions to all four management tasks, but the 

effectiveness of the solution depends on the level of development of the transport 

system. In addition, the solution of the last two tasks requires a fairly high level of 

development and organization (orderliness) of the transport system. 

Consider the content of management tasks in more detail. 

The tasks of stabilizing the system [39, 75–76] are the task of maintaining some 

of its initial controlled values, close to some constant setpoints, without taking into 

account the influence of perturbations acting on the controlled values. Controlled 

values in transport systems are, for example, the downtime of cars at stations, the 

volume of loading and unloading, transportation, and so on. Dispatchers constantly 

monitor the actual values of these indicators, ie compare them with the normative 

values, and in case of deviation from the normative ones make appropriate decisions. 

The task of the program occurs when the set values of the controlled values 

change over time in a predetermined way. For example, the dispatcher of the 
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automobile station on industrial transport in the performance of his duties is guided by 

the requests of the shops for the supply and cleaning of cars - the program of transport 

maintenance of production; the dispatcher of the sorting station monitors the 

observance of the plan of cargo formation - the document (program), which regulates 

the composition of each formed car, as well as the observance of the schedule of 

shipments. 

In cases where the scheme of changing the set values of the controlled values is 

not known in advance, the problem of tracking is solved, ie the most accurate 

compliance with the current state of the system to the variable controlled values. 

Controlled values [77] must be changed to bring the state of the system in line with the 

changed external and internal conditions. In this sense, the system that implements 

tracking is similar to the system that solves the problem of stabilization, but in the 

tracking system, the controlled values are not constant. The need for monitoring arises, 

for example, when driving in conditions of significant unevenness of cargo flows or 

frequent changes in the parameters of applications for the supply and cleaning of cars. 

In this case, the dispatcher must promptly adjust the formation plan, schedule, volume 

of shunting work, to ensure compliance with the basic regulatory performance of the 

station - the values of downtime and turnover of cars, the volume of loading and 

unloading, indicators of quality of customer service. In some cases, the control task can 

not be formulated as the task of ensuring compliance with the state of the system to a 

given (constant or variable), because information about the given state can neither be 

pre-entered into the control system or obtained during its operation. This situation 

arises, for example, during the management of a station operating in difficult changing 

conditions, if the purpose of management is to ensure optimal (maximum) compliance 

with the values of the station's performance in any mode of its operation. indicators of 

quality of transport service of clients. In some cases, the control task can not be 

formulated as the task of ensuring compliance with the state of the system to a given 

(constant or variable), because information about the given state can neither be pre-

entered into the control system or obtained during its operation. This situation arises, 

for example, during the management of a station operating in difficult changing 
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conditions, if the purpose of management is to ensure optimal (maximum) compliance 

with the values of the station's performance in any mode of its operation. indicators of 

quality of transport service of clients. In some cases, the control task can not be 

formulated as the task of ensuring compliance with the state of the system to a given 

(constant or variable), because information about the given state can neither be pre-

entered into the control system or obtained during its operation. This situation arises, 

for example, during the management of a station operating in difficult changing 

conditions, if the purpose of management is to ensure optimal (maximum) compliance 

with the values of the station's performance in any mode of its operation. since 

information about the specified state can be neither pre-entered into the control system, 

nor obtained in the course of its operation. This situation arises, for example, during 

the management of a station operating in difficult changing conditions, if the purpose 

of management is to ensure optimal (maximum) compliance with the values of the 

station's performance in any mode of its operation. since information about the 

specified state can be neither pre-entered into the control system, nor obtained in the 

course of its operation. This situation arises, for example, during the management of a 

station operating in difficult changing conditions, if the purpose of management is to 

ensure optimal (maximum) compliance with the values of the station's performance in 

any mode of its operation. 

Management systems that solve the problem of monitoring and optimization, 

more adequately respond to changes in external and internal conditions, adapt, adapt 

to these changes and, unlike systems that solve only the tasks of stabilization and 

implementation of programs, able to maintain their structure and maintain viability 

significant perturbing effects. For example, the management systems of domestic 

enterprises, formed in the stable conditions of the planned economy, were focused 

mainly on solving the first two management tasks. Under market conditions, such 

management systems are inefficient and need to be improved. Businesses that do not 

change their management system in a timely manner cannot adequately respond to 

market demands. Road transport, as a monopolist in the market of mass transportation 

for short, medium and long distances, 
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Urban freight transport management systems solve the following tasks [40, 81]: 

1) streamlining of cargo; 

2) maintaining a single accounting of cargo flows; 

3) optimization of the company's activities for the delivery of goods in large 

cities and regions, optimization of transportation and reduction of transport costs; 

4) planning, accounting and CONTROL processes related

 from 

shipment and delivery of goods and cargoes; 

5) reduction of cargo delivery costs; 

6) improving the quality of customer service; 

7) software reliability work all transport and road infrastructure

 and reduction impact automotive transport on the environment .; 

8) increasing the accessibility of transport services for all groups of the 

population. 

To automate the control process, automatic control systems are used. 

This section is dedicated to finding the best routes for the fleet of a distribution 

company that delivers goods from the distribution center to 25 retail centers. Each 

center has certain needs for goods, and each truck is characterized by a certain 

limitation of the capacity of the goods. 

The goal is to select fleet trucks according to a set of retail centers and distribute 

deliveries so as to reduce overall transportation costs. 

Therefore, you need to define a transport route (VRP). Once you have 

established the delivery sequence, you can develop step-by-step instructions for the 

resulting routes, which can be sent electronically or printed out and passed on to drivers 

working on delivery routes. 

Data for this and other Network Analyst tasks are available at ArcGIS.com. Once 

you've downloaded the data, you can drag it anywhere, but it's more convenient in the 

C: \ arcgis \ ArcTutor folder, as this folder is listed in the exercises as the default 

location for the training data. 
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Preparing the display  

Steps: 

1. Activate the ArcGIS Network Analyst plug-in by following these steps: 

a) click on Customize> Additional modules (Extensions). The Extensions dialog 

box opens; 

b) mark ArcGIS Network Analyst; 

c) click Close. 

If the Network Analyst toolbar doesn't appear, you'll need to add it. 

2. Click Customize> Toolbars> Network Analyst. 

The Network Analyst toolbar will be added to ArcMap (Figure 3.28). 

  

 

Figure 3.28 

If the Network Analyst window does not appear, you need to add it. 

3. On the Network Analyst toolbar, click the Network Analyst window. 

The attached Network Analyst window will open (Fig. 3.29). 

  

  

Figure 3.29 

  

The Network Analyst window can be pinned and unpinned. 

  

Create an analysis layer to select the transport route 

Steps: 
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1. Click Network Analyst on the Network toolbar Analyst and on the New 

Vehicle Routing Problem (Fig. 3.30). 

  

 

Figure 3.30 

  

The analysis layer of the transport route selection task has been added to the 

window 

Network Analysis Classes: Orders, Depots, Routes, Depot Visits, Breaks, Route 

Zones, Route Seed Points, Route Updates (Route Renewals), Special Requirements, 

Order Pairs, Point Barriers, Line Barriers and Polygon Barriers - Empty ). 

  

Figure 3.31 
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A new layer of analysis has also been added to the Table Of Contents window 

(Fig. 3.32). 

  

 

  

Figure 3.32 

Adding orders 

The location of the retail centers will be added to the Orders network analysis 

class. Orders can be submitted as orders that need to be fulfilled, as each retail center 

orders a certain amount of goods from the distribution center. Orders will eventually 

mark stops on the transport route. 

The location of retail centers has already been added as a Centers feature layer 

to the map document. The Centers layer attributes contain information about the total 

weight of the goods (in pounds) required by each center, the time when delivery should 

be performed and the time of unloading (in minutes) at each center. Unloading time is 

the time required to unload the goods. 
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These point characteristics of retail centers will be added to the analysis layer as 

an order. 

Steps: 

1. In the Network Analyst window, right-click the button Orders (Orders (0)) 

and choose Load Location (Load Locations) (Fig. 3.33). 

  

  

Figure 3.33 

The Load Locations dialog box opens. 

2. Select Centers from the Load Locations list. 

The Location Analysis Properties section of the Load locations dialog box allows 

you to specify which attributes of the Retail Centers feature class contain values that 

will be used by the ArcGIS Network Analyst Plugin when solving a transport route 

selection task. 

3. In the Location Analysis Properties section, make sure that the Name 

property automatically displays the NAME field and the Service Time property 

automatically displays the Service Time field. 
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The ArcGIS Network Analyst plug-in attempts to automatically link location 

analysis properties for a new transport route selection task layer using a configuration 

file located in the ArcGIS installation folder in [... [\ NetworkAnalyst \ 

NetworkConfiguration \ NASolverConfiguration.xml). 

4. Set the value of the Field of the Time Window Start 1 property for the 

Time Start 1 property (Fig. 3.34). 

  

 

Figure 3.34 

5. Set the Field value of the Time Window End 1 property for the Time End 

1 attribute. 

6. Set the Field value of the Delivery Quantities property for the Demand 

attribute. 

7. Enter a value of 0 on the Default Value tab for the Max Violation Time 1 

attribute. 

If you set the value of zero to this property, it will mean that the delivery time 

can not be violated (Fig. 3.35). 
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Figure 3.35 

8. Click OK. 

The 25 retail centers are listed in the Network Analyst window on the Orders tab 

as an order on the map. 

9. Double-click Store_1. 

The properties of the store are opened (Fig. 3.36). 
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Figure 3.36 

  

10. Set the required properties: Time Window Start 1 at 9 am (9:00:00), Time 

Window End 1 at 5 pm (17:00:00) (Fig. 3.37). 

  

Figure 3.37 
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11. Repeat steps 9 through 10 for the next 24 centers. 

 

Adding syllables 

Goods are delivered from a single distribution center, the location of which is 

marked on the Distribution Center spatial object layer in ArcMap. The distribution 

center is open from 8 am to 5 pm. This point characteristic must be added to the Depots 

network analysis class. 

Steps: 

1. In the Network Analyst window, right-click the button Warehouses 

(Depots (0)) and select Load Locations. 

The Load Locations dialog box opens Locations.  

2. Choose Center distribution (Distribution Center) with list Load Locations. 

3. In the Location Analysis Properties section make sure what property 

Name  automatically matches the NAME field. 

4. Enter a value of 8 AM in the Default Value field for the Time Window 

Start property 1. 

5. Enter a value of 5 PM in the Default Value field for the Time Window 

End 1 property (Figure 3.38). 

  

 

Figure 3.38 



174 

 

6. Click OK. 

One distribution center is listed in the Network Analyst window on the Depots 

tab and is displayed as a warehouse on the map. 

 

Add routes 

At the center of the distribution are three trucks, each of which can carry no more 

than 15 thousand pounds of goods. You need to add three routes (one for each truck) 

and set the properties for the routes according to the instructions of the distribution 

center. 

Steps: 

1. In the Network Analyst window, right-click the Routes (0) button and 

select Add Item (Fig. 3.39). 

  

  

Figure 3.39 
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The new route Element 1 will be added to the class tab Routes in the Network 

Analyst window, then the Properties window for the route will open. 

2. In the Properties window (Fig. 3.40) specify the attributes for the route, as 

shown in the table below. The description column provides explanations for each value. 

Do not change the default attribute values in the table. 

  

   Hint 

Use the following keyboard shortcuts to change the values in the Properties 

window: 

• Click the TAB or F2 key to change the outfit property. 

• Click the TAB key again to save the changes and proceed to change the next 

property. 

• Click SHIFT + TAB to save the changes and go to the previous property. 

  

Table 3.1 - Branches 

Name Value Description 

1 2 3 

Name Truck_1 Vehicle name 

(Start Depot Name) Kharkiv The truck starts moving along the route from the 

distribution center 

(End Depot Name) Kharkiv The truck returns to the distribution center at the 

end of the route 

(Start Depot Service Time) 60 The time (in this case in minutes) required to fully 

load the truck with goods 

(Earliest Start Time) 8 AM The truck can start delivery immediately after the 

opening of the distribution center at 8 o'clock 

(Latest Start Time) 8 AM The truck must start work as soon as possible 
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Continuation of table 3.1 

Capacity () 15,000 The truck can carry no more than 15 thousand 

pounds of goods 

(Cost Per Unit Time) 0.20 The driver of the truck receives $ 12 per hour, his 

salary can be calculated as $ 12/60 min = 0.20 cents 

per minute 

(Cost Per Unit Distance) 1.5 Average cost in dollars per mile, including fuel 

consumption, truck depreciation and maintenance 

(Max Order Count) 10 The maximum number of stores that can be 

serviced by a truck 

(Max Total Time) 360 Due to the restriction of the working day, drivers 

cannot work for more than 6 hours (360 minutes) 

 (Max Total Travel Time) 120 In order not to violate the restrictions of the 

working day and to serve a sufficient number of 

retail centers, given the time of unloading at each 

store, the truck should spend no more than 2 hours 

(120 minutes) on the streets 

(Max Total Distance) 80 To balance daily fuel and maintenance costs for 

the entire fleet, each truck must travel no more 

than 80 miles 

  

Figure 3.40 
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3. Click OK. 

The new Truck_1 route will be added to the route class in the Network Analyst 

window. 

Since the three trucks in the center of the distribution do not differ from each 

other, you can make two copies of the first truck and rename them. 

4. Right-click on the Truck_1 route object in the Network Analyst window 

and select Copy (Fig. 3.41). 

  

Figure 3.41  

5. Right-click on the Route class (1) in the Network Analyst window and 

select Paste (Fig. 3.42). 

  

Figure 3.42 
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 The Routes class contains two identical route objects. 

  

6. Repeat the previous step to create a third route object (Fig. 3.43). 

  

  

Figure 3.43 

  

7. Double-click on the second Truck 1 object from the list. 

The Properties window opens. 

8. Click on the Name property and enter Truck_2. 

9. Double-click the ENTER key. 

The route will be given a unique name and the window will close. 

10. Use the same procedure to change the name of the last route to Truck_3 

(Fig. 3.44). 

  

Figure 3.44 
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 Setting properties for the analysis of the task of determining the transport route 

Steps: 

1. Click the Analysis Layer Properties button in the Network Analyst 

window (Fig. 3.45). 

  

  

Figure 3.45 

  

2. The Layer Properties dialog box opens. 

3. Click the Analysis Settings tab. 

Make sure that the Time Attribute list that opens is set to Travel Time in Minutes. 

The VRP task solver uses this attribute to calculate costs between customers and 

warehouse on a time-based basis. 

4. From the Distance Attribute list, select Meters. 

This attribute is used to calculate the distances between customers and the 

warehouse in order to limit the creation of routes, although the purpose of the VRP task 

tool is to minimize costs in terms of time. 

5. Set the Default Date property to Day of Week. Choose Monday from the 

Day of Week list. 

6. Make sure the Capacity Count is set to 1. 

This value indicates that the goods being delivered are measured by only one 

indicator. In this case, this figure is weight (in pounds). If the capacity was indicated 

by two indicators, such as weight and volume, the capacity meter would have a value 

of 2. 

7. Make sure what value Minutes given the Time Field Units properties. 

This property indicates that all attributes are timed, such as Service 

Time and Max Violation Time 1 for the Orders class and Max Total Time, Max 

Total Travel Time and Cost Per Unit Time for the Route class, are set in minutes. 
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8. Make sure that the Distance Field Units property is set to Kilometers. 

This property indicates that all distance attributes, such as Max Total Distance 

and Cost Per Unit Distance, are specified in miles for the Routes class. 

9. Because these trucks cannot perform U-Turns at Junctions, the U-Turns at 

Junctions properties must be set to Not Allowed. 

10. Select Straight Line from the Output Shape Type list. 

If necessary, you can select True Shape with Measures or True Shape to route 

through the streets. Keep in mind that this setting only affects the display of routes, not 

the results determined by the VRP tool. 

11. Make sure Restricted Turns and One way are highlighted in the 

Restrictions section. 

12. Leave the parameters in the Directions set unchanged (Fig. 3.46). 

  

 

Figure 3.46 

13. Click OK. 
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The process of determining the best route and sequence of orders  

Steps: 

1. Click the Solve button Network Analyst toolbar. 

2. When receiving error messages, make sure that the Capacities attribute for 

routes is 15,000 instead of 15,000, and that each route is given a unique name (Figure 

3.47). 

  

 

  

Figure 3.47 

  

The VRP task calculator calculates the three routes required to service orders 

and draws the lines connecting the orders. Each route starts and ends at the distribution 

center and serves a set of orders on the corresponding route. 
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Defining step-by-step directions for routes 

  

Steps: 

1. Right-click the Routes (3) button in the Network Analyst window and 

select Selection> Clear Selected Features. 

2. Click the Directions Window button  Network Analyst toolbar. 

The Directions dialog box opens. 

3. In this case, you can export the transport route definition task layer as a 

layer file (<filename> .lyr) by right-clicking on the Vehicle Routing Problem button in 

the Table Of Contents window and selecting Save As. Save As Layer File. This 

command will save the analysis to disk, after which it can be added to another map 

document and used later. 

4. If you need to continue working and go to other sections of this exercise, 

you need to close the Directions window. Otherwise, exit ArcMap and do not save the 

changes to the Exercise 07.mxd file. 

  

Make changes to the decision to run another scenario 

The company decided on the transport route used earlier, but a few weeks later 

the driver of the Truck_2 route went on vacation. The distribution company must 

service the same number of retail centers using only two trucks. To accommodate the 

extra workload, the company decided to pay two other drivers overtime and give them 

one paid break during the day. The distribution company also acquired two additional 

distribution centers. These centers can be used by trucks to replenish loading and 

continue the delivery route instead of returning to the main distribution center for the 

next loading. You need to change the decision, take the previous step, and take these 

changes into account. 
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Delete the existing route from the solution 

In the Network Analyst window, right-click the Truck_2 object in the Routes 

class and select Delete 

(Fig. 3.48). 

  

  

Figure 3.48 

  

The selected Truck_2 object will be deleted. 

  

Add downloads on the route 

Two additional distribution centers, purchased by the company, are located on 

the street. Pushkinskaya, 25 and Plekhanovskaya, 66. They can be used for additional 

loading of trucks. Trucks can replenish loads in these distribution centers, and thus save 

time without returning to the original warehouse. New distribution centers need to be 

added to the Depots network analysis class, specifying the geocode of their address. 

Routes on which it is possible to replenish cargoes in additional distribution centers, 

and loading time in them are specified in a class of the analysis of a network 

Replenishment of loading on a route (Route Renewal). 

  

Steps: 
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1. In the Network Analyst window, left-click on the button Warehouses 

(Depots (1)). Then click the Find button on the toolbar (Fig. 3.49). 

 

Figure 3.49 

  

The Find dialog box opens. 

2. Select the Spatial Objects tab. 

3. Select the buildingall layer in the value of B (In) (Fig. 3.50). 

  

Figure 3.50 

  

4. In the Find text box, enter a street name - Pushkinskaya, 25. 

5. Click Find. 

6. Right-click in the Find dialog box (Find) and select Add as Network 

Analysis Object. 

The new address will be added as a warehouse to the Network Analyst window 

and display on the map (Fig. 3.51). 
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Figure 3.51 

  

7. In the Find text box, enter a street name - 66 Plekhanivska Street. 

8. Click Find. 

9. Right-click the new result at the bottom of the Find dialog box and select 

Add as Network Analysis Object. 

The third warehouse will be added as a network analysis class Warehouses 

(Depots) (Fig. 3.52). 

  

  

Figure 3.52 

  

10. Close the Find dialog box. 

As both trucks can update loads at Pushkinskaya, 25 and Plekhanovskaya, 66, it 

is necessary to "tie" each truck to two places of replenishment of loading. The program 

for solving the problem of choosing the route of transport will calculate the optimal 
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location of replenishment for trucks, as well as determine when they should replenish 

their stock of goods. 

11. In the Network Analyst window, right-click on the Route Renewals (0) 

button and select Add Item (Figure 3.53). 

  

  

  

Figure 3.53 

A new item replenishment object on Route Item1 will be added to the Oute 

Renewals class tab in the Network Analyst window, and then the Properties window 

for Item1 will open. 

12. In the Properties window, specify the attributes to replenish the download 

on the route, as shown in Table 3.2 and Figure 3.54. 
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Table 3.2 - Attributes to replenish the download on the route 

Attribute Value Description 

1 2 3 

(Depot Name) Pushkin, 25 Truck can use this composition to 

replenish cargo 

(Route Name) Truck_1 Vehicle name 

(Service Time) 30 Time in minutes required to load the 

truck goods 

  

  

  

Figure 3.54 

  

13. Click OK. 

A new boot replenishment object on Pushkin Route 25 will appear inside the 

Truck_1 element in the Network Analyst window. 

14. Follow the last three steps to add three more replenishment items on the 

route so that each truck (Truck_1 and Truck_3) can be replenished at both additional 

warehouses (Pushkinskaya, 25 and Plekhanovskaya, 66). 
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Figure 3.55 

  

In the Network Analyst window, two objects to replenish the load on the route 

inside the elements Truck_1 and Truck_3 should be displayed (Fig. 3.55). 

  

Change the route to include overtime 

To account for overtime, the company intends to eliminate restrictions on 

maximum time, maximum travel time and maximum distance for routes. Because 

drivers have to work harder, they will be paid overtime of $ 18 per hour for overtime 

of 6 hours. In this state, these changes will be made to the routes. 

Steps: 

1. In the Network Analyst window, on the Routes network analysis class tab, 

double-click Truck_1. 

The Properties window opens. 

2. Make changes to the Truck_1 attributes so that they match the values in 

Table 3.3 and Figure 3.56. 
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Table 3.3 - Changing attributes 

Attribute Value Description 

1 2 3 

(Overtime Start Time) 360 The driver gets overtime if he works for 

another 6 hours (360 minutes) 

(Cost Per Unit 

Overtime) 

0.3 The driver earns $ 18 an hour for 

overtime. Wages per minute is 18 dollars 

/ 60 minutes = 0.30 cents / minute 

(Max Order Count) 20 As the driver gets overtime, he has to go 

around more shops 

(Max Total Time) <null> The total working time of the driver is 

unlimited 

(Max Total Travel 

Time) 

<null> Time in on the road on streets 
unlimited 

(Max Total Distance) <null> The total distance traveled by the truck is 

unlimited 

 

 

Figure 3.56 
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3. Click OK. 

4. Repeat the last three steps for Truck 3. 

 

Add breaks 

  

Because drivers have to work longer, they will need a half-hour break during the 

work shift. In this step, you need to define breaks for each route. 

Steps: 

1. In the Network Analyst window, right-click the Breaks (0) button and 

select Add Item. 

The Properties window opens. 

2. Specify the attribute values for the new break, as shown in Table 3.4 and 

Figure 3.57.  

  

Table 3.4 - Attribute values for the new break 

Attributes Value Description 

1 2 3 

(Time 

Start) 

Window 
12:30 PM 

The break should start sometime after 

12 o'clock 30 minutes 

(Time 

End) 

Window 
1:30 PM 

The break should start somewhere 

before 13 hours 30 minutes 

(Route Name) Truck_1 Name route, for whose apply this break 

(Service Time) 30 Duration of the break in minutes 

(Max Violation 

Time) 

0 The break should start between 12 

o'clock 30 minutes and 13 hours 30 

minutes A value of zero indicates that 

the break cannot start after 13:30, ie the 

break time is fixed 

(Is Paid) Truth 

(True) 

This is a paid break, so the costs are 

included in the total cost of the route 
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Figure 3.57 

  

3. Click OK. 

4. Repeat the last three steps, specifying Truck_3 for the Route Name 

property. 

Now in the Network Analyst window there are two objects specified on the tab 

of the class Breaks - Truck_1 and Truck_3 (Fig. 3.58). 

  

  

Figure 3.58 
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Decision making 

  

Click the Solve button Network Analyst toolbar. 

The VRP task solution tool calculates two routes that can be used to service 

orders and draws straight lines connecting orders. Each route starts and ends at the 

distribution center, serves a set of orders on its way, drives to one recharge center, 

continues to serve the remaining orders, and finally returns to the distribution center 

(Fig. 3.59). 

  

 

  

Figure 3.59 

  

This decision coincides with the restrictions specified by the distribution 

company. However, after issuing travel letters to the two drivers, the company found 

that the driver of the Truck_1 truck knew the center of Kharkiv better, and the driver 

of the Truck_3 truck knew the Eastern district better. The company is trying to find a 
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new solution, which route would serve orders according to the capabilities of drivers. 

In the next steps, route points will be added that will take into account the wishes of 

drivers. 

  

Add route starting points 

Route starting points for Truck_1 and Truck_3 are determined by geographic 

address codes. Route exit points can also be imported from an existing feature class or 

created interactively using the Create Network Location tool ..  

Steps: 

1. In the Network Analyst window, left-click the Route Seed Points button 

(0). Then click the Find button on the toolbar (Fig. 3.60). 

  

 

Figure 3.60 

  

The Find dialog box opens. 

2. Select the Spatial Objects tab. 

3. Select the buildingall layer in the value of B (In) (Fig. 3.61). 

  

 

Figure 3.61 
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4. In the Find text box, enter a street name - Vesnina, 12. 

5. Click Find. 

6. Right-click on the Find dialog box and select Add as Network Analysis 

Object. 

The new address will be added as the base point of the route to the Network 

Analyst window and map display. 

7. In the Find text box, enter a street name - Klochkivska, 18. 

8. Click Find. 

9. Right-click the new result at the bottom of the Find dialog box and select 

Add as Network Analysis Object 

10. In the Network Analyst window, double-click on the new main route point 

- Spring, 12. 

The Properties dialog box opens. 

11. Specify the attribute values for the route starting point according to Table 

3.5 and Figure 3.62. 

  

Table 3.5 - Attribute values for the starting point of the route 

Attributes Value Description 

1 2 3 

(Route Name) Truck_1 Name route, for whose 

the starting point is used 

(Seed Point Type) Static As a result of this action, orders near 

the specified starting point will most 

likely be assigned to Truck_1 
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Figure 3.62 

  

12. Repeat steps 1–5 of this section to add the main route points located at 

Klochkivska, 18. 

  

  

Figure 3.63 

  

13. Repeat steps 6-7 to change the Route Name attribute of the second starting 

point to Truck_3 (Figure 3.63). 

  

Solution calculation 

Click the Solve button  Network toolbar Analyst.  
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The VRP task solution tool calculates two routes that can be used to service 

orders and draws straight lines connecting orders. The route for Truck_1 provides 

service only in the center of Kharkiv, and the route for Truck_3 passes through all 

shops in the Eastern district, as well as through several - in other parts of the city. 

  

3.3 Determining the location of retail facilities using gravity modeling 

  

It is necessary to determine the optimal location of retail facilities to ensure 

maximum profitability of the retail network [82-83]. The most important thing is to 

place shopping facilities near the centers of concentration of population and thus ensure 

demand for goods. Based on this approach, it has been suggested that residents are 

more willing to shop at nearby stores. You need to analyze the location distribution, 

using three types of tasks: maximizing attendance, increasing market share and target 

market. The differences between these types of tasks will become clearer after working 

out the exercise [84–87]. 

  

Preparing the display 

Steps: 

1. If the Exercise 09.mxd file is open in ArcMap, go to step 6. 

2. To start ArcMap, select Start> All Programs> ArcGIS> ArcMap 10.5. 

3. In the ArcMap - Getting Started dialog box, click Existing Maps> Browse 

for more. 

4. Navigate to the C: \ ArcGIS \ ArcTutor \ ArcGIS Network Analyst \ 

Tutorial \ Exercise09 folder. 

This is the default location for installing learning materials. 

5. Double-click the Exercise 9.mxd file. 

The map document will open in ArcMap. 

6. Activate the ArcGIS Network Analyst plug-in by running 

the following actions: 

a) click on Customize> Additional modules (Extensions). 
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The Extensions dialog box opens; 

b) mark ArcGIS Network Analyst; 

c) click Close. 

If the Network Analyst toolbar doesn't appear, you'll need to add it. 

7. Click Customize> Toolbars> Network Analyst. 

The Network Analyst toolbar will be added to ArcMap (Figure 3.64). 

  

 

Figure 3.64 

  

If the Network Analyst window does not appear, you need to add it. 

8. On the Network Analyst toolbar, click the Network Analyst window. 

The attached Network Analyst window will open (Fig. 3.65). 

  

  

Figure 3.65 

The Network Analyst window can be pinned and unpinned. 

  

Create a location analysis layer 

Steps: 

Click Network Analyst on the Network Analyst toolbar and New Location-

Allocation 

(Fig. 3.66). 
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Figure 3.66 

The Location-Distribution Analysis layer has been added to the Network Analyst 

window. Network Analysis Classes: Facilities, Demand Points, Lines, Point Barriers, 

Line Barriers, and Polygon Barriers - Empty (Fig. 3.67). 

  

Figure 3.67 

A new layer of analysis has also been added to the Table Of Contents window 

(Fig. 3.68). 

  

Figure 3.68 
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Adding potential objects 

It is necessary to add potential locations of trade objects to the class of analysis 

of the network of Objects. There are potential places where you can open a store. The 

decision in the process of placement-distribution involves the selection of these retail 

facilities. 

The location of potential trade objects has already been added as the Candidate 

Object layers to the map document. Store names are contained in the layer attribute 

table. Let's load point objects from Potential trade objects in the object class of the 

placement-distribution layer. 

Steps: 

1. In the Network Analyst window, right-click the button Facilities (0) and 

select Load Locations. 

The Load Locations dialog box opens. 

2. Select Potential Trade Objects (CandidateObject) from the Load From list 

(Fig. 3.69). 

 

Figure 3.69 
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The Location Analysis Properties section of the Load locations dialog box allows 

you to specify which attributes of the Potential Trade Objects class contain the values 

that Network Analyst will use when solving the placement-distribution task. 

3. In the Location Analysis Properties section, make sure that the Name 

property automatically matches the NAME field. 

Network Analyst tries to automatically associate location analysis properties 

for a new placement-distribution task layer using a configuration file (usually located 

in the ArcGIS installation folder in: \ Program Files \ ArcGIS \ Desktop10.5 \ 

NetworkAnalyst \ NetworkConfigurations \ NASolverConfiguration.xml). 

4. Click OK. 

16 potential trade objects are loaded into the network analysis class Objects. New 

trade objects are contained in the Network Analyst window and are displayed on the 

map (Fig. 3.70). 

  

 

Figure 3.70 
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Adding demand points 

Shopping facilities should be located as convenient as possible for the 

population. A point layer of centroids of adjacent census quarter groups has already 

been added to ArcMap. You need to load these centroids into the Demand points 

network analysis class. 

Steps: 

1. In the Network Analyst window, right-click the Demand Points (0) button 

and select Load Locations. 

2. Select Tract Centroids from the Load From list. 

3. In the Location Analysis Properties section, make sure that the Name 

property automatically matches the NAME field. 

4. Click the Field column for the Weight property and select POP2000. 

Each point of demand is estimated by population according to the 2016 census 

(Fig. 3.71). 

  

Figure 3.71 

5. Click OK. 

208 centroids from adjacent census groups are loaded into the Demand Points 

class. The new demand points are indicated in the Network Analyst window and 

displayed on the map (Fig. 3.72). 
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Figure 3.72 

Establish properties of location-distribution analysis 

Steps: 

1. Click the Analysis Layer Properties button in the Network Analyst 

window (Fig. 3.73). 

  

  

Figure 3.73 

  

The Layer Properties dialog box opens. 

2. Click the Analysis Settings tab. 

3. Make sure Impedance is defined as Travel Time (Minutes). 

4. Do not select Use Start Time. 
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If you want to calculate the location-distribution based on traffic at certain hours 

and days of the week, enter the start time here. 

5. In the Travel From section, specify Demand to Facility. 

The Default Facility to Demand option is optimal for classic impedance 

minimization and coverage maximization tasks. However, in the task of increasing 

attendance, increasing market share and target market, demand usually shifts to objects, 

so the choice from Demand to Facility is mostly good for such cases. 

6. Select Allowed from the U-Turns at Junctions drop-down list. 

7. In the Output Shape Type section, set the Straight Line. Although the 

source data is displayed as straight lines, the cost of moving is first measured over the 

network. 

8. Make sure Ignore Invalid Locations is checked. 

9. Make sure Restricted Turns and One way are highlighted in the 

Restrictions section. 

The Analysis Settings tab should look like this (Figure 3.74). 

 

Figure 3.74 
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10. Select the Advanced Settings tab. 

11. Click the Problem Type drop-down list and select element Software 

maximum attendance (Maximize Attendance). 

These types of tasks are usually used as an example. Ensuring maximum 

attendance is the best type of task for the location of retail outlets, as it is assumed that 

all outlets are equally attractive, and people are more willing to buy goods in stores 

located nearby. 

12. Select the number 3 in the Facilities To Choose window. 

ArcGIS will select three objects out of 16 that best serve 208 demand points. 

13. Select the number 5 in the Impedance Cutoff window. 

This setting means that people do not want to go to the store for more than five 

minutes. The unit of measurement for this value is determined by the unit of 

measurement of the impedance attribute. Because Travel Time is measured in minutes, 

this value is also given in minutes. 

14. Make sure that Impedance Transformation is set to Linear. ArcGIS will 

use a linear relationship when calculating the probability of visiting a particular store. 

Therefore, if the impedance limit of five minutes and the linear impedance conversion 

are applied, the probability of visiting a trade object decreases by 1/5, or 20% every 

minute, ie a trade object located one minute from the point of demand has the 

probability of visiting is 80%, in contrast to the shopping facility located four minutes 

away, for which the probability is only 20%. 

15. Click OK. 

  

The process of finding the best location of shopping facilities 

Steps: 

1. Click the Solve button   Network Analyst toolbar solution. 

At the end of the process, lines will appear on the map connecting the selected 

retail outlets with points of demand. Lines will also be displayed in the Lines class in 

the Network Analyst window (Fig. 3.75). 
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Figure 3.75 

Now you can read the results in more detail. 

2. In the Table Of Contents, right-click on the Facilities sublayer and select 

Open Attribute Table (Figure 3.76). 

  

  

Figure 3.76 

  

3. Check the attributes in the object table. The value of the three objects in 

the FacilityType field is set to Chosen instead of the default Candidate setting (Fig. 

3.77). 
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Figure 3.77 

The Demand Count column lists the demand points assigned to each of the 

selected objects. We must not forget that out of 208 demand points, only 62 were 

distributed among the selected objects, as others were located more than five minutes 

from them. 

The Demand Weight column shows the demand value for each item. In this case, 

the value is the number of people who will mainly buy goods in this store. 

4. Close the Facilities table. 

5. In the Table Of Contents, right-click on the Demand Points sublayer and 

select Open Attribute Table (Figure 3.78). 

  

 

Figure 3.78 
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Figure 3.79 

  

6. Check the attributes in the table of demand points (Fig. 3.79). If the point 

of demand is less than five minutes from the object, the Facility ID column is set to 

<Null>, the other value in this column is the identifier of the selected object to which 

belongs to the point of demand. 

The Weight column shows the number of inhabitants loaded from the Census 

tract. The Allocated Weight column shows the demand for a particular service point. 

The weight allocated to a particular service point is calculated based on the linear 

reduction in demand during the removal process and the five-minute impedance limit 

set in the Layer Properties dialog box. 

7. In the Table Of Contents, right-click on the Lines sublayer and select Open 

Attribute Table (Figure 3.80). 
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Figure 3.80 

  

The table shows one record for each point of demand assigned to a particular 

object. It also indicates the impedance of the shortest path between two objects and the 

weight accounted for by each object. 

8. Close the attribute table. 

  

Add the required object 

So, where you need to locate three new retail facilities, determined. Next, we 

consider the process of expansion of a retail facility using the method of placement-

distribution, when one retail facility already exists, and you need to better place two 

more. 

Steps: 

1. In the Network Analyst window, right-click the button Facilities (16) and 

select Load Locations. 

The Load Locations dialog box opens. 

2. Select Existing Object from the Load From list. 

3. In the Location Analysis Properties section make sure the Name property 

matches the NAME field. 
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4. In the Default Value column for the Facility Type, replace Candidate with 

Required. 

After loading the trade object, it will have the status Required. Mandatory 

objects are an integral part of the solution (Fig. 3.81). 

  

 

  

Figure 3.81 

  

5. Click OK. 

  

Establishing the properties of the analysis (ensuring maximum attendance with 

the selection of the required object) 

  

To solve this problem, use the same properties as in the previous section. 

Steps: 

1. Click the Analysis Layer Properties button in the Network Analyst 

window (Fig. 3.82). 
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Figure 3.82 

  

The Layer Properties dialog box opens. 

2. Make sure the Maximize Attendance task type is set, the number of objects 

searched is 3, the impedance limit is 5, and the impedance conversion is set to Linear. 

3. Click OK. 

  

The process of determining the optimal location of retail facilities (ensuring 

maximum attendance with the choice of mandatory facility) 

 

Click the Solve button Network Analyst toolbar. 

At the end of the process, the selected retail outlets will be connected to the 

demand points by lines. We must remember that the original solution has changed and 

the ExistingObject is part of the solution (Fig. 3.83). 

  

 

Figure 3.83 
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Adding competing objects 

The placement-distribution calculation mechanism allows you to place new 

retail outlets to increase market share given the presence of competitors. Market share 

is calculated using the Huff model, or gravity model. Huff's model assumes that the 

probability of visiting retail outlets by demand points is determined by some properties 

of these retail outlets, as well as the distance to them. 

Steps: 

1. In the Network Analyst window, right-click the button Facilities (17) and 

select Load Locations. 

2. Select Competitor Object from the Load From list. 

3. In the Location Analysis Properties section make sure what property 

Name  automatically matches the NAME field. 

4. In the Default Value column for the Facility Type, replace the Candidate 

with the Competitor (Figure 3.84). 

  

 

Figure 3.84 
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5. Click OK. 

6.  

Establishing the properties of the analysis (ensuring maximum market share) 

 

You need to change the properties of the placement-distribution analysis layer 

so that they can be used to solve a Maximize Market Share task. 

Steps: 

1. Click the Analysis Layer Properties button in the Network Analyst 

window (Fig. 3.85). 

  

  

Figure 3.85 

The Layer Properties dialog box opens. 

2. Select the Advanced Settings tab. 

3. Click the Problem Type drop-down list and select Maximize Market 

Share. 

4. Click the Impedance Transformation drop-down list and select Power. 

ArcGIS will be use degree dependence in the process of 

determining the probability of visiting a particular retail facility. We must remember 

that Impedance Parameter can be edited. 

5. Change the value of the Impedance Parameter to 2. 

The impedance parameter 2 under the condition of impedance transformation 

means that the probability of visiting a trade object decreases in proportion to the 

square of the distance between the points of demand and the location of the object. 

Typically, the exact value of the impedance parameter is calculated using other analysis 

tools, such as ArcGIS Business Analyst. 

6. Click OK. 
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The process of determining the optimal location of retail facilities (ensuring 

maximum market share) 

Steps: 

1. Click Network Analyst on the Network Analyst toolbar and Options. 

The ArcGIS Network Analyst Options dialog box opens (Figure 3.86). 

 

  

Figure 3.86 

   

  

2. Click the General tab. 

3. Select All Messages. 
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If you select the All Messages command in the tasks to ensure the maximum 

market share, the obtained market share will be displayed in the dialog box after the 

process is completed. 

4. Click OK. 

5. Click the Solve button Network Analyst toolbar. 

Upon completion of the process, a special notice will indicate the market share. 

6. Close the message. 

  

Demand points are connected on the map by lines with selected retail outlets and 

competitors. It should be remembered that the selected retail outlets have been changed 

to ensure maximum demand in the case of three competitors. 

The lines overlap more than in the previous decision, because each point of 

demand in the task of ensuring maximum market share can interact with all objects in 

the impedance zone. 

7. In the Table Of Contents, right-click on the Objects sublayer and select 

Open Attribute Table (Figure 3.87). 

  

  

  

Figure 3.87 
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For three objects, the Facility Type section is set to Competitor: one is Required 

and two are Chosen, which is the best calculation mechanism. 

The Demand Count column lists the demand points assigned to each object. It 

should be remembered that some demand points are not taken into account because 

they are located outside the five-minute impedance zone. 

The Demand Weight column shows the amount of demand for each selected 

object. The importance of stores, compared to the importance of competitors, makes it 

possible to single out the market share identified as a result of the decision. 

 8. Close the attribute table. 

 

Increasing target market share 

It is established that the total market share for the three selected retail outlets is 

18.20%. Assume that you need to reach a market share of 65%. To do this, you need 

to determine the minimum number of retail facilities required for this, and their 

preferred location. The task of increasing the target market share will help answer this 

question. 

Steps: 

1. Click the Analysis Layer Properties button in the Network Analyst 

window (Fig. 3.88). 

  

  

Figure 3.88 

  

The Layer Properties dialog box opens. 

2. Select the Advanced Settings tab. 

3. Click the Problem Type drop-down list and select Target Market Share. 

4. Keep in mind that if you change the task type to Increase Target Market 

Share, the Target Market Share (%) property will be editable. 
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Change the Target Market Share property (%) to 65. 

5. Click OK. 

 

Determining the optimal location of retail facilities (increase in target market 

share) 

Steps: 

1. Click the Solve button Network Analyst toolbar. 

Upon completion of the decision process, a special message will indicate the 

target market share and the number of retail outlets needed to achieve it. The target 

market share is more than 65%, because if a smaller number of retail outlets were 

opened, the target market share would be less than the required 65%. 

2. Close the message. 

Solution objects are connected on the map with demand points using lines. 

3. In the Table Of Contents, right-click on the Facilities sublayer and select 

Open Attribute Table (Figure 3.89). 

  

Figure 3.89  

In addition to the three competing trade objects and one obligatory trade object, 

sixteen trade objects have been created, the Facility Type of which is Chosen. Thus, to 

achieve the target market share of 65% requires sixteen additional retail outlets. 

4. Exit ArcMap. Click No to save the changes. 
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CONCLUSIONS 

  

The possibility of using geoinformation technologies for modeling transport 

networks has been established. The possibility of creating multimodal sets of network 

data that provide planning of transport activities using multiple networks is proved. 

Scientific and practical approaches to determining the impact of road networks 

on the basic indicators of the functioning of transport systems are studied. In the 

environment of modern information technologies to determine the basic characteristics 

of the road network of Ukraine used methods of network analysis. 

Scientific approaches to modeling the parameters of long-distance passenger 

connections are studied. It is determined that driving time affects the indicators of 

passenger transport correspondence as a factor of resistance to potential 

correspondence. This determines the importance (necessity) of determining the 

potential coverage of cities as transport hubs for the full period of time in the models 

of road networks. 

According to the results of the simulation of landfills with maximum passenger 

route transport accessibility for different modes of transport, it was found that the 

characteristics of the simulated set of landfills are influenced by the selected network 

model and connection speed. It is proved that at the same speed the polygons built in 

different networks differ. This is due to the individual characteristics of networks, 

which in each case are described by the pattern and number of links in the network. 

According to the results of the analysis of the current state of development of 

scientific approaches and methods of improving urban transport systems, there is a 

need to apply integrated approaches to the organization of transportation. 

The main directions of development of traffic management systems are 

determined. It is established that the most effective today are Automated Control 

Systems (Intelligent Transport System) and integrated into transport information. 

The possibility of using geographic information systems on the organization, 

planning and calculation of planned indicators of transport operation while taking into 

account multifactorial constraints is considered. 
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Gravitational modeling was used to analyze the location of objects. The 

provision of a comprehensive analysis of the object and a set of many factors and their 

interaction, which increases with the development of commercial real estate and 

increased competition. 

The model format of research allows making a decision on the implementation 

of the project at the pre-project stage, without spending effort and resources to develop 

the concept of future objects. The study simulates the location of retail facilities in the 

network using a gravity model (Huff model) on the example of Kharkiv. 
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